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How to use

B Meaning of signs
oKE
Letters enclosed in brackets indicate remote control buttons.
Menu :
Letters in cyan indicate on-screen display items.
=
References in this eHELP

You can jump to the page by pressing @E while the cursor is on the
references.

B Operation guide

//— A Forward
Back —(
—'/G— Back

Jump to menu item
- -
First page
How to use

= Note =
* The design and specifications are subject to change without notice.
* The images shown in this eHELP are for illustrative purposes only.

* This eHELP covers all models, however, some features may not be
available on certain models.

» Refer to the paper manual and the actual menu in the TV etc. to confirm
your model’s features.
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Read first

Before use

Licence

Even if no special notation has been made of company or product
trademarks, these trademarks have been fully respected.

DISEqQC™ is a trademark of EUTELSAT.

THX and the THX logo are trademarks of THX Ltd., registered in the United
States and other countries.

The Bluetooth® word mark and logos are registered trademarks owned by
Bluetooth SIG, Inc. and any use of such marks by Panasonic Corporation is
under license.

The terms HDMI and HDMI High-Definition Multimedia Interface, and the
HDMI Logo are trademarks or registered trademarks of HDMI Licensing
Administrator, Inc. in the United States and other countries.

x.v.Colour™ is a trademark.

Dolby, Dolby Vision, Dolby Atmos, Dolby Audio, and the double-D symbol are
trademarks of Dolby Laboratories.

Manufactured under license from Dolby Laboratories.
Confidential unpublished works.
Copyright © 2013-2015 Dolby Laboratories. All rights reserved.

Text-to-Speech Powered by Nuance

2002-2019 Nuance Communications, Inc. All rights reserved.
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“PlayReady” is a trademark registered by Microsoft. Please be aware of the
following.

(a) This product contains technology subject to certain intellectual property
rights of Microsoft. Use or distribution of this technology outside of this
product is prohibited without the appropriate license(s) from Microsoft.

(b) Content owners use Microsoft PlayReady™ content access technology to
protect their intellectual property, including copyrighted content. This device
uses PlayReady technology to access PlayReady-protected content and/or
WMDRM-protected content. If the device fails to properly enforce restrictions
on content usage, content owners may require Microsoft to revoke the
device’s ability to consume PlayReady-protected content. Revocation should
not affect unprotected content or content protected by other content access
technologies.

Content owners may require you to upgrade PlayReady to access their
content.

If you decline an upgrade, you will not be able to access content that requires
the upgrade.

This product incorporates the following software:
(1) the software developed independently by or for Panasonic Corporation,
(2) the software owned by third party and licensed to Panasonic Corporation,

(3) the software licensed under the GNU General Public License, Version 2.0
(GPL V2.0),

(4) the software licensed under the GNU LESSER GENERAL PUBLIC
LICENSE Version 2.1 (LGPL V2.1), and/or,

(5) open sourced software other than the software licensed under the GPL
V2.0 and/or LGPL V2.1.

The software categorized as (3) - (5) are distributed in the hope that it will be
useful, but WITHOUT ANY WARRANTY, without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. Please
refer to the detailed terms and conditions thereof shown in the “Software
Licence” menu on this product.

At least three (3) years from delivery of this product, Panasonic will give to
any third party who contacts us at the contact information provided below,
for a charge no more than our cost of physically performing source code
distribution, a complete machine-readable copy of the corresponding source
code covered under GPL V2.0, LGPL V2.1 or the other licenses with the
obligation to do so, as well as the respective copyright notice thereof.

Contact Information: oss-cd-request@gg.jp.panasonic.com
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The source code and the copyright notice are also available for free in our
website below.

https://panasonic.net/cns/oss/tv/EUIDTV19.html
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Features

4K resolution
You can watch content in 4K format that has twice the horizontal and vertical
resolution of the 1080p signal.

M - Watching > 4K resolution > 4K compatible equipment

-16 -



Home

‘Home” is a gateway to the TV programmes, applications and connected
devices.

It provides you an easy way to access all the features.

"M - Home > Home > Information
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TV Anytime

You can watch TV and set timer event with the network equipment
(smartphone, etc.) from outside the home network.

¢ Due to network conditions or certain broadcaster restrictions, this function
may not be available.

"8 - Functions > TV Anytime > How to use
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Dual Tuner

Only for dual tuner model

You can watch or record 2 programmes simultaneously, watch a programme
while recording another programme, etc.

"M - Functions > Multi Window > How to use
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Satellite TV

Only for the model supporting the satellite reception

Receives the digital satellite broadcasts.

"M - Watching > Basic > Basic connection
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Easy Mirroring
You can watch and display images of other devices (smartphone, etc.) on the
TV screen using a mirroring function. You can also start the mirroring function

from the other devices without operating the TV.

¥ - Functions > Mirroring > How to use
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Data Service Application

You can enjoy Hybrid Broadcast Broadband TV application that is one of the
interactive data services for digital broadcasting.

"8 - Functions > Data Service Application > Using Data Service Application
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Home

Home

Information

‘Home” is a gateway to the TV programmes, applications and connected
devices.

Home is displayed by pressing [gl®l¥l= and it provides you an easy way to
access all the features as shown below (example).

[1] Home
Devices

— Gateway to connected devices (HDMI equipment, USB device, network
equipment, etc.)

"M - Home > Devices
Apps
— Gateway to various applications (internet content, etc.)
"M - Home > Apps
[4] Live TV
— Gateway to TV programmes
"M - Home > Live TV
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* Be sure to update the software when a software update notice is displayed
on the TV screen. If the software is not updated, you may not be able to
use Home. You can update the software later manually.

"M - Network > Network settings > Software Update
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How to use

From Home, you can access all the features such as TV programmes,
applications and connected devices.

1. Display Home with [gle}\%[=.

(Example)

* Press A\ / N/ to display the tabs which provide you with the relevant
programme information, recommended content, etc.

* A broadband network environment is required to use internet services.
"M - Network > Network connections > Internet connection
2. Select Devices / Apps / Live TV and press m to access.

¢ To watch full-screen TV, select Live TV.

(Example)

= Note =

* The design and specifications are subject to change without notice.

B Search

You can search for content from various sources.

1. Display Home with [FIOIYI=.

2. Press /A to select Search and press m to access.

* A search history may be displayed and you can select it for keyword
search.

* To delete the search history
1) Select Search or a keyword and press (Olza1[®]\.
2) Select Delete all histories / Delete a history and press m

3. Follow the on-screen instructions.
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W Setting

You can set up Home, tabs, etc.

1. Display Home with [SIeJ¥=.

2. Press W/ repeatedly to display the setting tab.

3. Select one of the following items and press m to access.
Tab Settings / Enable Auto Pin / Disable Auto Pin

4. Follow the on-screen instructions.

Tab Settings
Edits the tabs of Home.

Enable Auto Pin / Disable Auto Pin

Selects whether to automatically add a shortcut for a feature frequently used
on Home.
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Pin to HOME

You can add a shortcut for a frequently used feature on Home.
Display Home with [JIe]Y=.

Select Devices / Apps / Live TV and press m to access.
Select a feature (device / application / TV programme).
Display the option menu with SJgi[eIN|

Select Pin to HOME and press to set.

Select the position to add on Home and press [8]4 to set.

2 e o

* To remove a shortcut from Home, set Unpin from HOME.

"M - Home > Home > Option menu
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Option menu

You can customise Home.

1. Display the option menu with [SJgii[®IN|.

2. Select one of the following items and press m to access.
Unpin from HOME / Move

3. Set the item and press [8]4 to store.

Unpin from HOME

Removes a shortcut from Home.

Move

Arranges the position of the icons.
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Devices

How to use

Connected devices (HDMI equipment, USB device, network equipment, etc.)
can be accessed easily from Devices.

1. Display Home with [gl®)\Y(=.

2. Select Devices and press [8]4 to access.

(Example)

* To exit Devices
* To add a shortcut icon
"8 - Home > Home > Pin to HOME
3. Select a device and press [8]4 to access.

* For external equipment

"M - Watching > External equipment
* For USB device

"M - Media Player > Using Media Player
* For network equipment

"8 > Network > Home network
* For mirroring function

"M - Functions > Mirroring

= Note =
* The design and specifications are subject to change without notice.
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Option menu
1. Display the option menu with [G]zaR[®]\.
2. Select one of the following items and press [8]4 to access.

Pin to HOME / Accessibility / Switch to Component / Switch to Video /
Show Info.

3. Set the item and press [8]4 to store.

Pin to HOME
Adds a shortcut for a frequently used feature on Home.

"M - Home > Home > Pin to HOME

Accessibility
Guidance settings for visually impaired users

"M - Watching > For best audio > Voice Guidance Settings

Switch to Component / Switch to Video
You can select COMPONENT and VIDEO in AV.

Show Info.

Displays the information about the selected device.
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Apps

How to use

Various applications (internet content, etc.) can be accessed easily from
Apps.

1. Display Home with [gl®)\Y(=.
2. Select Apps and press m to access.

(Example)

* To exit Apps
* To add a shortcut icon
"8 - Home > Home > Pin to HOME

* You can assign a favourite application to Y A#a\&x of the TV’s remote
control.

"8 > Home > Apps > Option menu
3. Select an application and press m to access.

4. Follow the on-screen instructions.

= Note =
* The design and specifications are subject to change without notice.

* Internet apps are provided by their respective service providers, and may
be changed, interrupted, or discontinued at any time.

* Abroadband network environment is required to fully use this function.
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Option menu
1. Display the option menu with [G]zaR[®]\.
2. Select one of the following items and press [8]4 to access.

Pin to HOME / Set as My App / Move / Lock / Unlock / Uninstall / Show
Info.

3. Set the item and press [8]4 to store.

Pin to HOME
Adds a shortcut for a frequently used feature on Home.

"M - Home > Home > Pin to HOME

Set as My App
Assigns your favourite application to VA#AE of the TV’s remote control.
[ is displayed on the assigned application.

* To change the assignment, set Set as My App while the cursor is on
another application.

Move

Arranges the position of the applications.

Lock, Unlock
Locks / unlocks a specific application to restrict access (if available).
* Child Lock PIN number is required to access to locked application.

"M - Functions > Child Lock > PIN number

Uninstall

Deletes an application from Apps (if available).

Show Info.

Displays the information about the selected application.

-32-



Live TV

How to use
Live TV is a gateway to the TV programmes.
1. Display Home with [SIeJ¥=.
2. Select Live TV.
3. Press [8]4 to access.
(Example)

* For details of watching TV
"8 - Watching > Basic
* To add a shortcut icon
"8 - Home > Home > Pin to HOME
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Option menu

1. Display the option menu with .

2. Select one of the following items and press m to access.
Pin to HOME / Accessibility / AV Options / Favourites

3. Set the item and press [8]4 to store.

Pin to HOME
Adds a shortcut for a frequently used feature on Home.

"M - Home > Home > Pin to HOME

Accessibility
Guidance settings for visually impaired users

"M - Watching > For best audio > Voice Guidance Settings

AV Options
Easy optional setting for viewing, sound, etc.
"M - Watching > Basic > AV Options

* Menu items and selectable options vary depending on the TV mode.

Favourites

Selects a favourite list for selecting a channel from the information banner, TV
Guide, etc.
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Watching

Basic

Basic connection

Some features are not available on all models.

Please ensure that the unit is disconnected from the mains socket before
attaching or disconnecting any cables.

* External equipment and cables shown are not supplied with this TV.

* Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting cables.

B Satellite dish

[1] Satellite terminal
Satellite cable
Satellite dish

* For Satellite TV

* To ensure your satellite dish is correctly installed, please consult your local
dealer. Also consult the received satellite broadcasting companies for
details.

» Selectable satellites and dish alignment to tune Satellite TV are as
following.

— OptusD1
— OptusD2
— OptusD3
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B Aecrial

[1] Aerial terminal
RF cable
Aerial

Keep RF (antenna) cable away from the mains lead to avoid and minimise
mains interference pickup.

Do not place the RF cable under the TV.

An aerial, correct cable (75 Q coaxial) and correct terminating plug are
required to obtain optimum quality picture and sound.

If a communal aerial system is used, you may require the correct
connection cable and plug between the wall aerial socket and the TV.

Your local Television Service Centre or dealer may be able to assist you
in obtaining the correct aerial system for your particular area and the
accessories required.

Any matters regarding aerial installation, upgrading of existing systems or
accessories required, and the costs incurred, are the responsibility of you,
the Customer.
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B DVD Recorder / Blu-ray Recorder, etc.

[] [4]
—— ———
b | g

5]
[1] Aerial terminal
RF cable
DVD Recorder / Blu-ray Recorder, etc.
[4] Aerial
[5] HDMI terminal
[6] HDMI cable
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B Set top box

[1] HDMI terminal
HDMI cable
Set top box
[4] Satellite dish

= Note =
* For details of VIERA Link connections
"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link
* Please also read the manual of the equipment being connected.

* Keep the TV away from electronic equipment (video equipment, etc.) or
equipment with an infrared sensor, otherwise distortion of image / sound
may occur or operation of other equipment may be affected.

* Use a fully wired HDMI compliant cable.
* Use a high speed HDMI cable for high resolution images.

* Check the terminal type and cable plugs are correct for connection.
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Selecting channel

Some features are not available on all models.

1.

Select the mode with [,
Satellite TV / Digital TV / Analogue TV

* The selected mode is displayed on the top left of the screen.

SEICla =R ER I EIRYIGEChannel Up / Downffsl@dNumeric buttonsh
Al @D@EmDE
E1E]E]
FEIED
@

* Press \UnEhleRelliehE! to select a channel position with 2 or more-digit
(e.g. 399, press 37 (81 @1).

To select a channel from the channel list

1. Display the channel list with [§J&.

-_

Select a channel from the list and press [8]4 to watch.

To select a channel using information banner

. Display information banner with [INIg®) if it is not displayed.

Select a channel and press to watch while the banner is displayed.

i“M - Watching > Basic > Information banner

B To select a channel using TV Guide

1.

Not valid in Analogue TV
Display TV Guide with [€18]|B]=.

2. Select the current programme and press m to access.

3. Select View and press [8]4 to watch.

"M - Watching > TV Guide > Using TV Guide
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Information banner

Some features are not available on all models.

Display information banner with [[N|Z®].

* Also appears when changing a channel.

(Example)

"

[1] Channel position and name
Channel type (Radio, etc.) / Encrypted channel (Fel) / TV mode (%1, s, )
Programme
Start time / End time (Satellite TV / Digital TV)
Channel position, etc. (Analogue TV)
[4] Category
[5] Date and time
[6] Features available / message meanings
Rating:
Rating information
"M - Functions > Child Lock > Parental Rating
Bad signal:
Poor quality TV signal
AD:
Audio Description service available

* This function can aid visually-impaired viewers by providing an
additional audio track to describe events on screen.

"M - Watching > For best audio > Audio Description
:

Subtitle service available
(i) :

Multiple image or audio available
:

Teletext service available
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@ I, I, Vv:
Audio mode
"M - Watching > For best audio > Advanced settings
:
Data service (Hybrid Broadcast Broadband TV application) available
"M - Functions > Data Service Application > Using Data Service Application
1-90:
Off Timer remaining time

"8 - Watching > Basic > Off Timer

To confirm another tuned channel
FANAY
To watch the channel listed in the banner

Information on the next programme (Satellite TV / Digital TV)
>
Extra information (Satellite TV / Digital TV)
INFO
— Press again to hide the banner.
To hide the banner
To update the TV software (if available)
B (red)
To select a favourite list (Satellite TV / Digital TV)
"M - Home > Live TV > Option menu

— If the favourite list is created in Favourites Edit.

"8 - Watching > Tuning and editing channels > Favourites Edit

To adjust banner timeout, set Banner Display Timeout.
1) Display the menu with [Y[=NY).

2) Select Setup > Display Settings > Banner Display Timeout and press
EE to access.

3) Set the item and press [8]4 to store.
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AV Options

Confirm or change the current status.
* Display the image full-screen to use this function.
1. Display the option menu with .
2. Select AV Options and press @E to access.
3. Select one of the following items and press m to access.

Audio Description / Video Selection / Audio Selection / AD / Dual Audio /
Subtitle Language / MPX / Volume Correction

* The function items vary depending on the TV mode.

4. Set the item and press m to store.

Audio Description

Set to On if the programme has Audio Description service, then you will hear
an additional audio track to describe events on screen (if available).

* For Digital TV
* Not valid in multi window mode
* To adjust the volume for Audio Description

"M - Watching > For best audio > Audio Description

Video Selection
Selects from a group of multiple videos (if available).

* This setting is not memorised and it returns to the default setting once you
exit the current programme.

* For Digital TV

* New Zealand only

Audio Selection / AD

Selects between alternative language or Audio Description for sound tracks (if
available).

* This setting is not memorised and it returns to the default setting once you
exit the current programme.

* For Digital TV
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Dual Audio
Selects stereo / monaural (if available).
* For Digital TV

Subtitle Language
Selects between alternative subtitle languages or types (if available).

* This setting is not memorised and it returns to the default setting once you
exit the current programme.

* For Digital TV
¢ Not valid on the sub screen in multi window mode

* New Zealand only

MPX
Selects multiplex sound mode (if available).
i“M - Watching > For best audio > Advanced settings

* For Analogue TV

Volume Correction

Adjusts the volume of each individual channel or input mode.
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Subtitle
Display / hide subtitles (if available) with SIRES.
e For Digital TV

* To select the preferred language for digital TV subtitles (if available), set
Preferred Subtitles.

"M - Watching > Basic > Language
— New Zealand only

» To select the preferred subtitle type
1) Display the menu with .

2) Select Setup > Display Settings > Subtitle Type and press EE to
access.

3) Select Standard / Hard of Hearing and press [8J4 to set.

— Hard of Hearing provides aids in understanding and enjoyment with
digital channel subtitles (depending on the broadcaster).

— New Zealand only

= Note =

* If you press in Analogue, the TV switches to teletext service and
calls up a favourite page. Press to return to TV mode.

¢ Not valid on the sub screen in multi window mode
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Last view
Switch to a previously viewed channel or input mode easily with [WASTRVAIRUY

* Press again to return to the current view.

= Note =
» Switching channel may not be available depending on the condition.

* Watching less than 10 seconds is not reflected in the previously viewed
channel or input mode.
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Off Timer
Switch to TV Standby mode automatically after a fixed period.
1. Display the menu with [YI=N[¥].
2. Select Timer > Off Timer and press 84 to access.
3. Select the time in 15-minute increments and press [8]4 to set.
90/75/60/45/30/15/ Off (minutes)
* To cancel, set to Off or turn the TV off.
* The remaining time is displayed on the bottom right of the screen.

* The remaining time will flash on the screen when less than 3 minutes.
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Energy saving functions
The TV can be eco-friendly using energy-saving functions.
The TV goes into Standby mode in the following conditions:
* Eco Navigation is set to Set to Eco.
» Off Timer is active.
"M - Watching > Basic > Off Timer
* No operation is performed for 4 hours while Auto Standby is set to On.

* No signal is received and no operation is performed for 10 minutes while
No signal Power off is set to On.

= Note =

* This function does not affect the recording.

B Auto Standby

1. Display the menu with [YI=N[¥].

2. Select Timer > Auto Standby and press [8]4 to access.
3. Select On / Off and press [8J4 to set.

Auto Standby
(On / Off)

Automatically turns the TV to Standby mode for energy saving when no
operation is performed for 4 hours.

* Automatic input switching with the connected equipment affects this
function and time-count resets.

* A notification message will appear 3 minutes before going into Standby
mode.

» Changing the default configuration may result in higher energy
consumption of the product.
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B No signal Power off

1. Display the menu with [YI=\N[¥).

2. Select Timer > No signal Power off and press [8J4 to access.
3. Select On / Off and press [8J4 to set.

No signal Power off
(On / Off)

Automatically turns the TV to Standby mode to prevent unnecessary power
consumption when no signal is received and no operation is performed for
10 minutes.

* A notification message will appear 3 minutes before going into Standby
mode.

B Eco Navigation

1. Display the menu with .

2. Select Setup > Eco Navigation and press m to access.
3. Select Set to Eco and press [8JX to set.

Eco Navigation
Automatically sets the TV to the most suitable energy-saving mode.

The concerned items and their current settings are displayed. Select Set to
Eco to set them to the energy-saving settings at once.

» Auto Standby and No signal Power off are active when Eco Navigation is
set to Set to Eco.
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Adjusting time

Some features are not available on all models. Available menu items are displayed on your TV screen.

Settings for the system time of this TV.

1. Display the menu with .

2. Select Timer > Clock Settings and press m to access.

3. Select one of the following items and press [8]4 to access.

Mode / Date / Time / Daylight Saving Time / Select State / Territory

4. Set with (S demes or NIETEIIELE, and press X to store.

EE

E1EIE]

EEIED
@

Mode
(Auto / Manual)
Selects the clock setting mode for this TV.

» Set to Auto to adjust the time automatically using the time information from
the digital broadcast. Set to Manual to adjust manually.

Date

Sets the current date manually.

Time

Sets the current time manually.
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Daylight Saving Time

(+ 1 hour / + 1/2 hour / Off / Auto)

Selects time offset from the standard time for Summer Time. (Base on GMT)
* If there is a gap between displayed time and actual time, set this function.

* Normally select Auto to adjust as following for the region has been set in
Select State / Territory.

NSW / ACT / Victoria / Tasmania: +11:00
South Australia: +10:30

Queensland: +10:00

Northern Territory: +9:30

Western Australia: +8:00

* Australia only

Select State / Territory

(NSW / ACT / Victoria / Queensland / South Australia / Western Australia /
Northern Territory / Tasmania)

Selects the region where you live to adjust the standard time. (Base on GMT)

* The time contained in the broadcast signal is UTC (Universal Time
coordinated) formally known as GMT (Greenwich Mean Time).

NSW / ACT / Victoria / Queensland / Tasmania: +10:00
South Australia / Northern Territory: +9:30
Western Australia: +8:00

* Australia only

-50 -



Language

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].

2. Select Setup > Language and press EE to access.

3. Select one of the following items and press [8]4 to access.
OSD Language / Preferred Audio Language / Preferred Subtitles
4. Set the item and press [8]4 to store.

OSD Language

Changes language for on-screen displays.

Preferred Audio Language

Selects the preferred language for digital channel multi audio (depending on
the broadcaster).

* New Zealand only

Preferred Subtitles

Selects the preferred language for digital channel subtitles (depending on the
broadcaster).

* To display subtitles
"M - Watching > Basic > Subtitle

* New Zealand only
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4K resolution

4K compatible equipment

You can watch content in 4K format that has twice the horizontal and vertical
resolution of the 1080p signal.

* For details of valid 4K format
"M - Watching > 4K resolution > Valid 4K format

* Connect the 4K compatible equipment to HDMI terminal using a 4K
compatible cable and you can watch content in 4K format.

* Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting cables.

B 4K compatible equipment

| w—a =

[1] HDMI terminal

HDMI cable

4K compatible equipment
* Check the terminal type and cable plugs are correct for connection.
* Use a fully wired HDMI compliant cable.

* Use a high speed HDMI cable for high resolution images.
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HDMI Auto Setting

1. Display the menu with .

2. Select Setup > HDMI Auto Setting and press m to access.
3. Set the item and press [8]4 to store.

HDMI Auto Setting
(Mode1 / Mode2)

Reproduces the image more precisely with the expanded colour gamut when
connecting the 4K compatible equipment. Select the mode depending on the
equipment.

Mode1:

For better compatibility. Set to Mode1 when the image or sound in
HDMI input is not played properly.

Mode2:

For the 4K compatible equipment that has the function to output the
image precisely with the expanded colour gamut

* The setting can be stored for each HDMI input.
* Valid format (4K)
— Mode1: 4:4:4 [ 4:2:2 (30p, 25p, 24p), 4:2:0 (60p, 50p)
— Mode2: 4:4:4 ] 4:2:2 (30p, 25p, 24p), 4:4:4 | 4:2:2 ] 4:2:0 (60p, 50p)
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Valid 4K format

B Valid 4K format (HDMI)

® 4K UHD
3840 x 2 160 (60p, 50p, 30p, 25p, 24p)
— Aspect is fixed to 16:9.

e DCIl4K
4 096 % 2 160 (60p, 50p, 30p, 25p, 24p)
— Actual resolution is 3 840 x 2 160p.
— Aspect is fixed to V Full.

= Note =
* The above signals are reformatted for optimal viewing on your display.
* For details of aspect

"M - Watching > For best picture > Aspect
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External equipment

External connection

Some features are not available on all models.

These diagrams show our recommendations for connection of your TV to
various pieces of equipment. For other connections, consult the instructions
for each piece of equipment.

¢ For details of basic connection

"8 - Watching > Basic > Basic connection

To use the specific devices supporting Bluetooth wireless technology

"M - Functions > Bluetooth devices

Check the terminal type and cable plugs are correct for connection.

External equipment and cables shown are not supplied with this TV.

Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting cables.

B HDMI equipment

o SURP St 4 11

[1] HDMI terminal
HDMI cable

Recorder / Player / Set top box / Camcorder / Amplifier with speaker
system

= Note =
* Use a fully wired HDMI compliant cable.
* Use a high speed HDMI cable for high resolution images.
* For details of VIERA Link connections
"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link

* Use HDMI2 to connect the TV to an amplifier which has ARC (Audio
Return Channel) function.
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B AV devices

o] g
| @I
| ©

&

[1] AV IN (COMPONENT) terminals
Component cables (Shielded)

* Use shielded component cables.
DVD Player, etc.
[4] Audio cables (Shielded)

* Use shielded audio cables.
[5] AV IN (VIDEO) terminals
[6] Composite cable (Shielded)

* Use shielded composite cable.

Camcorder / Game equipment
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B USB devices

[1] USB port
USB cable
USB HDD, etc.

= Note =
* |tis recommended to connect the device to the TV’s USB port directly.

You cannot use two or more of the same kind of USB devices
simultaneously except USB Flash Memory or USB HDD.

Use USB 1 or USB 2 port for connecting the USB HDD. (Refer to the terminal

indication of TV set.)

Some USB devices or USB HUB may not be used with this TV.

You cannot connect any devices by using USB card reader.

B Listening with external speakers

- <= ilnli

[1] DIGITAL AUDIO OUT
Optical digital audio cable
Amplifier with speaker system

* To enjoy multi-channel sound from external equipment (e.g. Dolby
Audio (Dolby Digital) 5.1ch), connect the equipment to the amplifier. For
information about the connections, read the manuals of the equipment and
amplifier.

* To select the sound output to adjust the volume, set TV Speaker Setting.

"M - Watching > For best audio > Volume settings
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B Headphones

[1] Headphone jack
3.5 mm stereo mini plug
Headphones
* To use headphones, set Headphone Terminal Output to Headphone.
"8 > Watching > For best audio > Headphone terminal output setting

* Do not connect a sub woofer while Headphone Terminal Output is set to
Headphone.

* To adjust the volume, set Headphone Volume.
"M - Watching > For best audio > Headphone terminal output setting
* To select the sound output to adjust the volume, set TV Speaker Setting.

i“M - Watching > For best audio > Volume settings

B Sub woofer

.
M. -

[1] Headphone jack
Audio cable (3.5 mm stereo mini plug - audio pin plug)
Sub woofer
* To use a sub woofer, set Headphone Terminal Output to Sub Woofer.

"M - Watching > For best audio > Headphone terminal output setting

* Do not connect headphones while Headphone Terminal Output is set to
Sub Woofer.

* To adjust the volume, set Sub Woofer Adjustment.
"M - Watching > For best audio > Headphone terminal output setting

* The volume of the sub woofer can be also controlled when adjusting the
volume of this unit with this TV’s remote control.
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Watching external input

Connect the external equipment (VCR, DVD, etc.) and you can watch through
the input.

1. Display the input selection menu with N

2. Select the input mode connected to the equipment and press to watch.
(The selected mode is displayed on the top left of the screen.)

* You can also select the input pressing N Press repeatedly until the
desired input is selected.

* You can select COMPONENT and VIDEO in AV.

* You can label or skip each input mode. Skipped inputs will not be
displayed when N is pressed. (Input Labels)

* The remote control is capable of operating the content or external
equipment.

- | Watching > External equipment > Operating with TV’s remote control

e To return to TV mode

= Note =
¢ |If the external equipment has an aspect adjustment function, set it to 16:9.

* For details, read the manual of the equipment or ask your local dealer.

M Input Labels

Accessing the input labels list allows you to change the input name or skip
the input if unconnected, improving identification and selection in the Input
Selection banner.

"8 - Watching > Basic > Information banner
1. Display the menu with .
2. Select Setup > Display Settings > Input Labels and press m to access.
3. Set the item and press [0l to set.

* To name each input mode freely, select User input and set characters
(maximum 10 characters).

* To skip the input mode, select Skip.
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B Playing Time Display
Set to On to display a time period of continuous use in Game Mode on the top
right of the screen every 30 minutes.

1. Display the menu with \Ji=\18).

2. Select Setup > Display Settings > Playing Time Display and press m to
access.

3. Select On / Off and press [8]4 to set.

¢ This function is available when Game Mode is set to On.
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Operating with TV’s remote control

You can operate the content in Media Player / media server, recording
functions or the connected equipment with the following buttons of this TV’s
remote control.

1]

Playback (VCR / DVD / video content)
(=]:

Stop the operations

[Eal

[==]:
Rewind, view the picture rapidly in reverse (VCR)
Skip to the previous track, title or chapter (DVD / video content)
(also available for the operation of USB HDD Recording) (Australia only)

Press and hold to search backward (DVD / video content)

[l

(o] :
Fast-forward, view the picture rapidly forward (VCR)
Skip to the next track, title or chapter (DVD / video content)
(also available for the operation of USB HDD Recording) (Australia only)
Press and hold to search forward (DVD / video content)
(n]:
Pause / Resume
Press and hold to play at slow speed (DVD)
(=]:
One Touch Recording

"M - Recording > Recording current programme > One Touch Recording
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B How to change the code

Each Panasonic product has its own remote control code. Change the code
according to the product for operation.

1. Press and hold Standby On / Off switch during the following operations.

o

2. Enter the appropriate code as follows with [N\[Fgl=li{eRe[0li(e]gk!.
E1E]
EIEIED

MEIE
@]

* Codes for each product and features
70: DVD Recorder, DVD Player, Blu-ray Disc Player
71: Player theatre, Blu-ray Disc theatre
72: VCR
73 (default):

Using in USB HDD recording, Media Player, in-house streaming or
VIERA Link

3. Press [=] to change.

= Note =
* Confirm if the remote control works correctly after changing the code.
* The codes may be reset to defaults if batteries are replaced.

* Some operations may not be available depending on the equipment.
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HDMI features

HDMI (high-definition multimedia interface) is the world’s first complete digital
consumer AV interface complying with a non-compression standard.

HDMI allows you to enjoy high-definition digital images and high-quality
sound by connecting the TV to external equipment.

HDMI-compatible equipment* with an HDMI or DVI output terminal, such as a
DVD player, a set top box or game equipment, can be connected to the HDMI
terminal using a fully wired HDMI compliant cable.

* .

"M - Watching > External equipment > External connection

The HDMI logo is displayed on HDMI-compliant equipment.

Applicable HDMI features
Input audio signal:

LPCM, Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby TrueHD),
Dolby Atmos

— Audio settings can be made on HDMI| Audio Format in the Sound
Menu.

"M - Watching > For best audio > Advanced settings

Input video signal:

Matches the output setting of the digital equipment.

"M - Watching > External equipment > Valid input signals
VIERA Link (HDAVI Control 5)

"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link
Content Type

Deep Colour

Audio Return Channel

— Audio Return Channel (ARC) is a function to send digital sound signals
via an HDMI cable.

— For HDMI2
x.v.Colour™
4K

"M - Watching > 4K resolution > Valid 4K format
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B DVI connection

If the external equipment has only a DVI output, connect to the HDMI terminal
via a DVI to HDMI adaptor cable. When using the DVI to HDMI adaptor
cable, connect the audio cable to the audio input terminal (use AV IN audio
terminals).

* Enquire HDMI adaptor cable at your local digital equipment retailer shop.

= Note =

* Audio settings can be made on HDMI Audio Format / HDMI Input in the
Sound Menu.

"M - Watching > For best audio > Advanced settings

* |f the connected equipment has an aspect adjustment function, set the
aspect ratio to “16:9”.

* These HDMI connectors are “type A”.

* These HDMI connectors are compatible with HDCP (High-Bandwidth
Digital Content Protection) copyright protection.

* Equipment having no digital output terminal may be connected to the input
terminal of component or video to receive analogue signals.

* This TV incorporates HDMI™ technology.
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HDMI HDR Setting

1. Display the menu with .

2. Select Setup > HDMI HDR Setting and press m to access.
3. Set the item and press [8]4 to store.

HDR Setting
(Dynamic / Static / Off)
Set to Dynamic or Static when the HDR device is connected to the TV.

* Please turn Off this function if the image looks unnatural. This may occur
in some cases such as compatibility with the connected device, source
images or with use of multi-window function.

* Image may disappear for a few seconds when the setting is changed.
* For HDMI

HDR Dynamic Setting

HDR10+ Functionality
(On / Off)
Enables the HDR10+ function for HDMI input signal.

Dolby Vision

(On / Off)
Enables the Dolby Vision function for HDMI input signal.

= Note =

» Supporting HDR does not increase the peak brightness capabilities of the
TV panel.
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HDMI 2.1 Settings

1. Display the menu with .

2. Select Setup > HDMI 2.1 Settings and press m to access.
3. Set the item and press [8]4 to store.

ALLM

(On / Off)

Automatically switches the TV to Game Mode according to the ALLM
information when using this TV in single window mode.

* For HDMI
* Not valid when HDMI Auto Setting is set to Mode1
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Valid input signals

B COMPONENT, HDMI

Signal name

COMPONENT

HDMI

525 (480) / 60i, 60p

o

625 (576) / 50i, 50p

o

750 (720) / 60p, 50p

o

1125 (1 080) / 60i, 50i

1125 (1 080) / 60p, 50p, 24p

3840 x 2 160 / 60p, 50p,
30p, 25p, 24p

4 096 x 2 160/ 60p, 50p,
30p, 25p, 24p

o: Applicable input signal

= Note =

» Signals other than those above may not be displayed properly.

* The above signals are reformatted for optimal viewing on your display.

¢ For details of valid 4K format

"M - Watching > 4K resolution > Valid 4K format
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For best picture
Viewing Mode

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [{I=\8].

2. Select Picture > Viewing Mode and press (@14 to access.

3. Select the mode and press [8]4 to set.

Viewing Mode

(Dynamic / Normal / Professional Photo / Cinema / THX Cinema / THX Bright
Room / True Cinema / Custom / Professional1 / Professional2 / Dolby Vision
Vivid / Dolby Vision Bright / Dolby Vision Dark)

Selects your favourite picture mode for each input.
Dynamic:
Improves contrast and sharpness for viewing in a bright room.
Normal:
Normal use for viewing in a normal lighting condition.
Professional Photo:
Reproduces the original image for photo.
* For photo content
Cinema:

Improves the performance of contrast, black and colour reproduction
for watching a film in a darkened room.

THX Cinema*:

Reproduces the original image quality precisely in a darkened room.
THX Bright Room*:

Reproduces the original image quality precisely in a bright room.
True Cinema:

Reproduces the original image quality precisely without any revision.
Custom:

Adjusts each menu item manually to suit your favourite picture quality.
Professional1 / 2:

Allows you to set and lock the professional picture settings.

"M - Watching > For best picture > Advanced Settings

» |If a certified professional dealer sets these modes, Professional1
and Professional2 may be displayed as isf Day and isf Night.
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Dolby Vision Vivid:
Reproduces Dolby Vision content precisely in a bright room.
Dolby Vision Bright:

Reproduces Dolby Vision content precisely in a normal lighting
condition.

Dolby Vision Dark:
Reproduces Dolby Vision content precisely in a darkened room.
* The following items can be adjusted and stored for each mode.

Luminance Level / Backlight / Contrast / Brightness / Colour / Tint /
Sharpness / Colour Temperature / Vivid Colour / Colour Remaster /
Rec.2020 Colour Remaster / Adaptive Backlight Control / Ambient Sensor /
HDR Brightness Setting / Noise Reduction / MPEG Remaster / Resolution
Remaster / Dynamic Range Remaster / Intelligent Frame Creation / Clear
Motion

* This function can be memorised respectively for input or TV mode.

: THX modes are used to mirror the picture settings used by professional
filmmakers, faithfully reproducing the image quality of THX Certified
movies. THX Certified movies have the THX logo on the disc. THX modes
are not available for photo content.

B Netflix Calibrated Mode

Reproduces the image quality based on the professional monitor settings
while watching Netflix.

1. Display the menu with \Ji=\18).
2. Select Picture > Netflix Calibrated Mode and press [8]4 to access.
3. Select On / Off and press [8]4 to set.

* Ambient Sensor / HDR Auto Brightness are not available and Viewing
Mode is fixed to Netflix when Netflix Calibrated Mode is set to On.

¢ For Netflix content
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Aspect

Some features are not available on all models. Available menu items are displayed on your TV screen.

Change the aspect ratio (image size) with [ASI-=03].

B To change the aspect ratio manually
1. Display Aspect Selection with .
2. Select the mode and press 8] to set.
* You can also change the mode by pressing .
(Press repeatedly until you reach the desired mode.)
16:9:
Directly displays the image at 16:9 without distortion (anamorphic).
4:3:
Displays the image at the standard 4:3 without distortion.
Zoom:
Displays a 16:9 letterbox or 4:3 image without distortion.
4:3 Full:
Displays a 4:3 image enlarged horizontally to fit the screen.
V Full:
Displays the image enlarged vertically to fit the screen without distortion.
* For DCI 4K format

= Note =
* Display the image full-screen to use this function completely.

* Aspect mode can be memorised separately for SD (Standard definition)
and HD (High definition) signals.

* Aspect cannot be changed in teletext service.
* Aspect is fixed to 16:9 in the following conditions:
— Game Mode is set to On.
— 1080p Pure Direct is set to On.
— 4K Pure Direct is set to On.
— 1080p Pixel by 4pixels is set to On.
— 4K content except DCI 4K

-70 -



Basic settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].

2. Select Picture and press 84 to access.

3. Select one of the following items and press [8]4 to access.

Luminance Level / Backlight / Contrast / Brightness / Colour / Tint /
Sharpness / Colour Temperature / Vivid Colour / Colour Remaster /
Rec.2020 Colour Remaster / Adaptive Backlight Control / Resolution
Remaster / Dynamic Range Remaster / Intelligent Frame Creation / Clear
Motion

4. Set the item and press [8]4 to store.

Luminance Level, Backlight, Contrast, Brightness, Colour, Tint, Sharpness
Adjusts the levels of these options according to your personal preference.

* Sharpness is not available when 1080p Pixel by 4pixels is set to On.

Colour Temperature

Sets the overall colour tone of the picture (bluer - redder).

Vivid Colour
(On / Off)

Automatically adjusts colours to vivid ones.

Colour Remaster

(Max / Min / Off)

Displays the vivid images with the expanded colour gamut.
* Not valid in the following conditions:

— Viewing Mode is set to Dolby Vision Vivid, Dolby Vision Bright or Dolby
Vision Dark.

— Viewing Mode is THX mode.
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Rec.2020 Colour Remaster
(On / Off)
Displays the vivid images with the suitable colour gamut.

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

* This function is available only for Rec. 2020 and displayed instead of
Colour Remaster.

Adaptive Backlight Control

Automatically controls the level of backlight according to the images.

Resolution Remaster
(Auto / Max / Mid / Min / Off)
Enhances picture resolution to make the image sharper.

* Not valid when 1080p Pixel by 4pixels is set to On

Dynamic Range Remaster
(On / Off)

Enhances bright areas of the image closer to the original luminance making
improved picture impact.

* Not valid in the following conditions:
— Multi window

— HDR video signal

Intelligent Frame Creation
(Custom / Max / Mid / Min / Off)

Automatically compensates the picture frame rate and removes juddering
movements to make the images smooth.

* Depending on the content, images may be noisy. To prevent the noise,
change the setting.

» Select Custom to set Intelligent Frame Creation manually.
Blur Reduction:
Adjusts the smoothness of camera content to minimise blur.
Film Smooth:

Adjusts the smoothness of film content.
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Black Frame Insertion:
Makes the blurring image clearer for video content, etc.
— Not valid for photo content

Reset to Defaults:
Resets items for Intelligent Frame Creation.

* Not valid in the following conditions:

— Game Mode is set to On.

— 1080p Pixel by 4pixels is set to On.

— 1080p Pure Direct is set to On.

— 4K Pure Direct is set to On.

— Photo content

Clear Motion
(On / Off)
Makes the moving pictures clearer by controlling the level of backlight.

* Not valid for photo content
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Ambient Sensor

1. Display the menu with .

2. Select Picture > Ambient Sensor and press [8]4 to access.
3. Select On / Off and press [8]4 to set.

Ambient Sensor
(On / Off)
* Automatic Brightness Control function

Adjusts picture settings automatically depending on ambient lighting
condition.

* Not valid for HDR video signal
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HDR Brightness Setting
1. Display the menu with .
2. Select Picture > HDR Brightness Setting and press m to access.
3. Select one of the following items and press [8]4 to access.
Dynamic HDR Effect / HDR Auto Brightness / HDR Brightness Enhancer
4. Set the item and press [8] to store.

Dynamic HDR Effect
(On / Off)
Automatically adjusts the luminance according to an HDR video signal.

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

HDR Auto Brightness
(On / Off)

Automatically adjusts the luminance according to a lighting condition.

HDR Brightness Enhancer
Adjusts the luminance when watching an HDR video in a bright environment.

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

= Note =

» Supporting HDR does not increase the peak brightness capabilities of the
TV panel.
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Noise reduction settings
1. Display the menu with .

2. Select Picture > Noise Reduction / MPEG Remaster and press 8 to
access.

3. Set the item and press (0] to store.

Noise Reduction
(Auto / Max / Mid / Min / Off)
Reduces unwanted picture noise.

* Not valid in the following conditions (The condition may differ depending on the model.):

— Game Mode is set to On.

— 1080p Pure Direct is set to On.

— 4K Pure Direct is set to On.

— 1080p Pixel by 4pixels is set to On.

MPEG Remaster
(Auto / Max / Mid / Min / Off)
Reduces flicker noise in contoured parts of a picture and block noise.

* Not valid in the following conditions (The condition may differ depending on the model.):

— Game Mode is set to On.

— 1080p Pure Direct is set to On.

— 4K Pure Direct is set to On.

— 1080p Pixel by 4pixels is set to On.
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Advanced Settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

You can adjust and set up the detailed picture settings when Viewing Mode
is set to Professional Photo, Cinema, True Cinema, Custom, Professional1
/ 2, Dolby Vision Bright or Dolby Vision Dark. The settings in True Cinema,
Custom or Professional1 / 2 can be stored for each input.

"M - Watching > For best picture > Viewing Mode
Select the input mode with N or .
Display the menu with JI=\8).

Select Picture > Viewing Mode and press (0] to access.

oL D=

Select the mode and press [8J4 to set.

Professional Photo / Cinema / True Cinema / Custom / Professional1 /
Professional2 / Dolby Vision Bright / Dolby Vision Dark

Adjust the detailed picture settings
Display the menu with .

Select Picture > Advanced Settings and press [8]4 to access.

@ N = n

Select one of the following items and press 84 to access.

Contrast Control / Colour Gamut / Photo Colour Gamut / White Balance /
Colour Management / Gamma / Reset Picture Defaults

4. Set the item and press [8]4 to store.

B Contrast Control
Contrast Control
(Custom / Auto / Off)

Automatically adjusts the detailed contrast settings. Select Custom to set
Contrast Control Setting manually.

Contrast Control Setting
Adaptive Gamma Control:
Adjusts the gamma curve to make the image brighter.
Black Expander:
Gradually adjusts the shades of black.
Clear White Effect:

Makes the white area clearer.
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Reset Contrast Control:

Resets items for Contrast Control Setting.

B Colour Gamut / Photo Colour Gamut
Colour Gamut
(Auto / Normal / Native / Rec. 709 / SMPTE-C / EBU / Rec. 2020 / DCI-P3)
Reproduces image colour precisely according to the colour gamut standards.
Auto:
Automatically adjusts the colour gamut according to the input signal.
Normal:
Displays colours according to the colour gamut.
Native:
Displays deep colours by expanding the colour gamut to its maximum.
Rec. 709:
Standard for HD (High definition)
SMPTE-C:
Standard for NTSC
EBU:
Standard for PAL
Rec. 2020:
Provides the suitable colour gamut for Rec. 2020.
DCI-P3:
Provides the suitable colour gamut for DCI 4K.
» Set Colour Remaster to Off to use this function.

¢ Set Rec.2020 Colour Remaster to Off to use this function for the Rec.
2020 signal.

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

Photo Colour Gamut
(Auto / sSRGB / Adobe / Rec. 2020)
Auto:
Automatically adjusts the colour gamut according to the input signal.
sRGB:
Standard for sSRGB
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Adobe:
Standard for AdobeRGB
Rec. 2020:
Provides the suitable colour gamut for Rec. 2020.

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

B \White Balance

R-Gain / G-Gain / B-Gain

Adjusts the white balance of bright red / green / blue areas.

R-Cutoff / G-Cutoff / B-Cutoff

Adjusts the white balance of dark red / green / blue areas.

More Detailed Adjustment
Adjusts more detailed items for White Balance.
Input Signal Level:
Adjusts the input signal level.
R-Gain / G-Gain / B-Gain:
Adjusts the detailed white balance of bright red / green / blue areas.
Reset White Balance:

Resets items for More Detailed Adjustment.

Reset White Balance

Resets White Balance to the default settings.

B Colour Management

R-Hue / R-Saturation / R-Luminance

Adjusts the picture hue / saturation / luminance of red areas.

G-Hue / G-Saturation / G-Luminance

Adjusts the picture hue / saturation / luminance of green areas.
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B-Hue / B-Saturation / B-Luminance

Adjusts the picture hue / saturation / luminance of blue areas.

More Detailed Adjustment
Adjusts more detailed items for Colour Management.
C-Hue / M-Hue / Y-Hue:
Adjusts the picture hue of cyan / magenta / yellow areas.
C-Saturation / M-Saturation / Y-Saturation:
Adjusts the saturation of cyan / magenta / yellow areas.
C-Luminance / M-Luminance / Y-Luminance:
Adjusts the luminance of cyan / magenta / yellow areas.
Reset Colour Management:

Resets items for More Detailed Adjustment.

Reset Colour Management

Resets Colour Management to the default settings.

B Gamma

Gamma
Switches the gamma curve.

* Please note the numerical values are reference for the adjustment.

More Detailed Adjustment
Adjusts more detailed items for Gamma.
Input Signal Level:
Adjusts the input signal level.
Gain:
Adjusts the gain of gamma for selected signal level.
Reset Gamma:

Resets items for More Detailed Adjustment.

Reset Gamma

Resets Gamma to the default settings.
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B Reset Picture Defaults

Reset Picture Defaults

Resets Advanced Settings to the default settings.
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Option Settings
Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].
2. Select Picture > Option Settings and press [8J4 to access.

3. Select one of the following items and press [8]4 to access.

Game Mode / Film Cadence Mode / 1080p Pure Direct / 4K Pure Direct /
1080p Pixel by 4pixels / HDMI Content Type / HDMI EOTF Type / HDMI
Colorimetry Type / HDMI RGB Range / HDMI YCbCr Range / EOTF Type /
3D-COMB

4. Set the item and press [8]4 to store.

Game Mode

(On / Off)

Provides suitable images for fast response signals when playing games.
* Not valid in TV mode

* To display a continuous record of time spent using Game Mode, set
Playing Time Display.

Film Cadence Mode
(Auto / On / Off)
Improves vertical resolution for movie images.

* This function is available for interlaced signals (except in the mode of multi
window, Network services or when Game Mode is set to On).

1080p Pure Direct
(On / Off)
Reproduces the original image quality in detail for 1080p (HDMI) input signal.
* Not valid in the following conditions:
— Multi window

— Viewing Mode is set to Dolby Vision Vivid, Dolby Vision Bright or Dolby
Vision Dark.

— 1080p Pixel by 4pixels is set to On.
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4K Pure Direct
(On / Off)
Reproduces the original image quality in detail for 4K (HDMI) input signal.
* Not valid in the following conditions:
— Multi window

— Viewing Mode is set to Dolby Vision Vivid, Dolby Vision Bright or Dolby
Vision Dark.

1080p Pixel by 4pixels
(On / Off)
Displays like pixel by pixel to make the image sharper for 1080p signal.
e For HDMI
* Not all image may be displayed as pixel by pixel precisely.
* Not valid in the following conditions:
— Multi window

— Viewing Mode is set to Dolby Vision Vivid, Dolby Vision Bright or Dolby
Vision Dark.

HDMI Content Type
(Graphics / Photos / Auto / Off)

Adjusts the picture settings of each HDMI input according to the selected
content type.

Auto:

Automatically adjusts the picture settings according to the received
HDMI content if the connected equipment supports HDMI Content
Type.
* To set the availability of each content type for Auto mode, select Auto
Detail Setting.
e For HDMI

* Not valid when Viewing Mode is set to Professional Photo, Dolby Vision
Vivid, Dolby Vision Bright or Dolby Vision Dark
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HDMI EOTF Type

(Auto / Traditional gamma / HLG / PQ)

Selects the EOTF type for each HDMI input. Set to Auto for general use.
e For HDMI

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

HDMI Colorimetry Type

(Auto / Rec. 601 / Rec. 709 / Rec. 2020)

Selects the colourimetry type for each HDMI input.
* For HDMI

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

HDMI RGB Range

(Auto / Full / Normal)

Adjusts the black level of the image for each HDMI input.
* When the black level is not suitable, select Full.
* For HDMI

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

HDMI YCbCr Range

(Full / Normal)

Adjusts the black level of the image in the YCbCr signal for each HDMI input.
* For HDMI

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark
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EOTF Type
(Auto / Traditional gamma / HLG / PQ)
Selects the EOTF type of broadcast or video content.

It works correctly only when the signal corresponds the each EOTF type. Set
to Auto for general use.

* Automatically switches to Auto for broadcast each time another input /
channel is selected.

* For Digital TV, video content

* Not valid when Viewing Mode is set to Dolby Vision Vivid, Dolby Vision
Bright or Dolby Vision Dark

3D-COMB
(On / Off)
Makes still or slow moving pictures more vivid.

* Occasionally, while viewing still or slow moving pictures, colour patterning
may be seen. Set to On to display sharper and more accurate colours.

* For PAL / NTSC signal reception in TV mode or from composite
connection
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Screen Settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

1.
2.
3.

Display the menu with WI=NE).
Select Picture > Screen Settings and press [8]4 to access.
Select one of the following items and press [8]4 to access.

16:9 Overscan / Zoom Adjustments / Screen Display / Pixel Orbiter / Logo
Luminance Control / Panel Maintenance / Panel Maintenance Message

. Set the item and press [8J4 to store.

16:9 Overscan
(On / Off)

Selects the screen area displaying the image for 16:9 aspect.

On:

Enlarges the image to hide the edge of the image.
Off:

Displays the image in the original size.
Set to On if noise occurs on the edge of the screen.

This function can be memorised for SD (Standard definition) and HD (High
definition) signals respectively.

Not valid in the following conditions:

— Photo content

— Game Mode is set to On.

— 4K content

— 1080p Pixel by 4pixels is set to On.
— 1080p Pure Direct is set to On.

— 4K Pure Direct is set to On.

— Multi window

Zoom Adjustments

Adjusts the vertical position and size when aspect is set to Zoom.

* Not valid in the following conditions:

— 4K content

— Multi window
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Screen Display
(On / Off)
Turns the screen off when you select Off.

* This function is effective in reducing power consumption when listening to
the sound without watching the TV screen.

* Press any buttons (except Standby On / Off switch) to turn the screen on.

Pixel Orbiter
(On / Off)

Sets the pixel shifting of the image to prevent panel “image retention”.

Logo Luminance Control
(Max / Mid / Min)

Adjusts the luminance level of the displayed logo to prevent panel “image
retention”.

Panel Maintenance

Turns the screen off and perform the maintenance to prevent the panel
‘image retention”.

* |t takes approx. 80 minutes to finish the maintenance.
e LED turns to orange during adjustment of the panel.

¢ To cancel the maintenance, turn the TV on while the maintenance is in
progress.

* A white horizontal line appears on the screen for a while to adjust the
panel. This is not a malfunction.

* Completion message will be displayed when turning the TV on after panel
maintenance.
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Panel Maintenance Message

(On / Off)

Enables to display the regular panel maintenance notification.
On:

The message automatically displays for maintenance when the TV is
turned off with Standby On / Off switch of the TV’s remote control after
watching for a certain period of time.

Off:

The message does not display. Select Panel Maintenance and perform the
panel maintenance manually. (see above)
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Lock Settings

Only for the OLED TV

Locks the settings of Professional1 / 2 for each input.
» Select Professional1 / Professional2 in Viewing Mode in advance.
"M - Watching > For best picture > Viewing Mode
1. Display the menu with [YI=\N[¥].
2. Select Picture > Lock Settings and press (0] to access.
3. Enter the PIN number (4 digits) with [T eReR oS-
E1ED
it
(]
* Enter the PIN number twice at first setting.
* Make a note of the PIN number in case you forget it.
4. Select Adjustment Lock and press [8]4 to access.
5. Select On and press [8]4 to set.
* The following items can be locked.

Luminance Level / Contrast / Brightness / Colour / Tint / Sharpness /
Colour Temperature / Vivid Colour / Resolution Remaster / Dynamic
Range Remaster / Advanced Settings / Reset Picture Defaults

B To change the PIN number
1. Select Change PIN and press [8]4 to access.

2. Enter a new PIN number twice with [N\¥aaElleNelbli{e]ats .
AOEIED
EEE
EIE
[@
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Copy Adjustment

Some features are not available on all models. Available menu items are displayed on your TV screen.

Copies the picture settings of True Cinema, Custom, Professional1,
Professional2, Dolby Vision Bright or Dolby Vision Dark to those of the other
input mode or Viewing Mode.

1. Display the menu with \Ji=\18).

2. Select Picture > Copy Adjustment > Destination Viewing Mode /
Destination Input and press [8]4 to access.

3. Select the destination to copy to and press m to set.
4. Select Copy Start and press [8]4 to copy.

5. When a confirmation screen is displayed, select Yes and press m to set.

= Note =
* Option Settings and Screen Settings are not copied.

* You cannot copy to the locked mode.

-90 -



For best audio

Sound mode

1. Display the menu with .

2. Select Sound > Mode and press 84 to access.
3. Select the mode and press [8JX to set.

Mode
(Standard / Music / Speech / Stadium / User)
Selects your favourite sound mode for each input.
Standard:
Provides the suitable sound quality for all types of scenes.
Music:
Improves sound quality for watching music videos, etc.
Speech:
Improves sound quality for watching news, drama, etc.
Stadium:
Improves sound quality for watching sports, etc.
User:

Adjusts the sounds manually using the equaliser to suit your favourite
sound quality.

* The following items can be adjusted and stored for each mode.
Bass / Treble / Surround / Bass Boost

* For the User mode, Equaliser is available in the Sound Menu instead of
Bass and Treble. Select Equaliser and adjust the frequency.

"M - Watching > For best audio > Basic settings

* This function is effective only for the sound from TV speakers.
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Basic settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].
2. Select Sound and press [8]4 to access.

3. Select one of the following items and press [8]4 to access.

Bass / Treble / Equaliser / Balance / Dolby Atmos / Sound Field Creation /
Surround / Bass Boost

4. Set the item and press [8]4 to store.

Bass

Adjusts level to enhance or minimise lower, deeper sound output.

Treble

Adjusts level to enhance or minimise sharper, higher sound output.

Equaliser

Adjusts the frequency level to suit your favourite sound quality.
* This function is available when Mode is set to User.
» Select the frequency and adjust the frequency level.

* To enhance the bass sound, raise the level of the lower frequency. To
enhance the treble sound, raise the level of the higher frequency.

* To reset the levels of each frequency to the default settings, select Reset
Equaliser Settings and press [€J&.

* This function is effective only for the sound from TV speakers.
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Balance
Adjusts the volume level of speakers.
L/R:

Adjusts the volume level of Front Left, Upward-firing Left speakers and
Front Right, Upward-firing Right speakers.

Center:

Adjusts the volume level of centre speaker and other speakers.
Up/Down:

Adjusts the volume level of Upward-firing speakers and others.
Reset to Defaults:

Resets Balance to the default settings.

Dolby Atmos
(On / Off)

Provides the precise sound of Dolby Atmos when playing Dolby Atmos
content. Set to On for general use.

Sound Field Creation
(Standard / Studio / Theater / Stadium / Direct Through)

Selects your favourite sound field setting.

Surround

(Dolby Surround / Cinema Surround Pro / Cinema Surround / Stadium
Surround / Off)

Selects surround sound settings.
Dolby Surround:

Provides a surround sound just like the Dolby Atmos content for all
input.

Cinema Surround Pro:

Provides a more progressive sound for watching a film by improving
spatial effects.

Cinema Surround:

Provides a suitable sound for watching a film by improving spatial
effects.
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Stadium Surround:

Provides a dynamic sound for watching sports by improving spatial
effects.

* This function is effective only for the sound from TV speakers.

* Not valid for Dolby Atmos content

Bass Boost
(On / Off)
Enhances the effect of bass sounds.

* This function is effective only for the sound from TV speakers.
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Volume settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].
2. Select Sound and press [8]4 to access.
3. Select one of the following items and press [8]4 to access.

Speaker Selection / TV Speaker Setting / Auto Gain Control / Volume
Correction / Clear Sound Adjustment / Dialogue Enhancement / Space
Tune Setting

4. Set the item and press [8]4 to store.

Speaker Selection
(TV / Home Cinema)

Enables controlling the theatre speaker with this TV’s remote control by
pointing at the TV’s signal receiver.

TV:
TV speakers are active.
Home Cinema:

The sound is delivered from theatre speakers. Player theatre, Blu-
ray Disc theatre or Amplifier will be automatically turned on if it is in
Standby mode.

* The sound of TV speakers is mute. When the equipment is turned
off, TV speakers will be activated.

* You can use (I[N CRS WA\, and (SRS

* This function is available when the theatre speakers supporting VIERA
Link function is connected to this TV.

TV Speaker Setting
(TV Speaker / Headphone / Off)
Selects the sound output to adjust the volume.

* Sound from TV speaker turns off when Headphone or Off is selected.
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Auto Gain Control
(On / Off)

Automatically regulates large sound level differences between channels and
inputs.

Volume Correction

Adjusts the volume of each individual channel or input mode.

Clear Sound Adjustment
(On / Off)

If the sound from TV speakers is unclear due to installation environment, On
is recommended.

* This function is effective only for the sound from TV speakers.

Dialogue Enhancement
(On / Off)

Enhances the intelligibility of dialogue and commentary.

Space Tune Setting

Adjusts the sound quality automatically according to the installation location
or room condition.

Space Tune
(On / Off)

Enables the sound setting which has been adjusted by Space Tune
Adjustment.

Space Tune Adjustment

Adjusts the sound setting with the Space Tune function.
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Headphone terminal output setting

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].
2. Select Sound and press [8]4 to access.

3. Select one of the following items and press [8]4 to access.

Headphone Terminal Output / Headphone Volume / Sub Woofer
Adjustment

4. Set the item and press [8] to store.

Headphone Terminal Output
(Headphone / Sub Woofer)
Selects the sound output from the headphone terminal.
Headphone:
The sound outputs for using headphones.
Sub Woofer:

The sound outputs for using sub woofer.

= Note =
* Normally set Headphone Terminal Output to Headphone.

* When Headphone Terminal Output is set to Sub Woofer, the headphones
cannot be used properly because only the low-frequency sounds are
output.

* The volume of the sub woofer can be also controlled when adjusting the
volume of this unit with this TV’s remote control.

Headphone Volume

Adjusts the volume of headphones.

Sub Woofer Adjustment
Adjusts the sound output of sub woofer.

Sub Woofer Volume:
Adjusts the volume of sub woofer.

¢ Confirm the actual sound volume from this TV and sub woofer and
adjust the volume.
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Cut Off Frequency:
Adjusts the cut-off frequency of sub woofer signal output.

* The frequency output to the sub woofer is less than the set cut-off
frequency.

* The frequency can be adjusted from 100 Hz to 400 Hz.

¢ Confirm the actual sound volume from this TV and sub woofer and
adjust the volume.

Reset Sound Defaults:

Resets Sub Woofer Adjustment to the default settings.
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Voice Guidance Settings
1. Display the menu with .
2. Select Sound > Voice Guidance Settings and press m to access.
3. Select one of the following items and press [8]4 to access.
Voice Guidance / Speed / Volume / Language / User Level / Web Browser

4. Set the item and press [8]4 to store.

Voice Guidance
(On / Off)

Set to On to enable voice guidance of the basic features (on-screen
messages, etc.) for visually impaired users.

¢ Not valid in multi window mode

Speed
(Fast / Normal / Slow)

Selects the readout speed for the voice guidance.

Volume
(Max / Mid / Min)

Selects the volume for the voice guidance.

Language

Changes language for the voice guidance.

User Level
(Beginner / Expert)

Selects the level of verbosity for the voice guidance.

Web Browser
(On / Off)

Set to On to enable voice guidance of the network content in web browser
function.

= Note =

* Voice guidance function may not correspond exactly.
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Audio Description
1. Display the menu with .
2. Select Sound > Audio Description and press m to access.
3. Select one of the following items and press [8]4 to access.
Audio Description / Volume
4. Set the item and press [8]4 to store.
* For Digital TV

Audio Description

(On / Off)

Narration settings for visually impaired users

Set to On to activate the narration sound track when available from broadcast.

* The availability of audio description sound track is indicated by AD in the
information banner.

¢ Not valid in multi window mode

Volume

Adjusts the volume for Audio Description.
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Advanced settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].

2. Select Sound and press [8]4 to access.

3. Select one of the following items and press [8]4 to access.

MPX / Digital Audio Preference / SPDIF Selection / HDMI Audio Format /
PCM Optical Level / HDMI Input

4. Set the item and press [8]4 to store.

MPX
Selects multiplex sound mode (if available).
Stereo:
Use this normally.
Mono:
When stereo signal cannot be received
M1/ M2:
Available while mono signal is transmitted

* For Analogue TV

When you receive the stereo / bilingual sound system, sound output modes
can be selected by using the MPX in the Sound Menu.

* Meanings of mode indicators
@ : STEREO
I : MAINI
I :SuUB Il
v : MONO
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B Available mode indicator for each type of broadcast
* NICAM - Used in New Zealand, Singapore, Hong Kong, etc.

Regular broadcast (Standard Audio): No indicator / ¥
Regular + NICAM MONO | (MAIN I): T/ ¥

NICAM STEREO: @/ V

NICAM DUAL MONO (MAIN1/SUBII): I /IM/ ¥

* A2 (German) - Used in Australia, Malaysia, etc.

Regular broadcast (Standard Audio): No indicator / ¥
BILINGUAL or DUAL MONO (MAIN I/SUBII): I /1L
STEREO: @/ ¥V

= Note =

* |f the stereo signal is poor or the receiving conditions are not optimum or if
STEREO:MONO automatic switching occurs, it is recommended to switch

from STEREO to MONO.

» Selected mode is not affected when the contents of the receiving signal

change.

* When the receiving conditions deteriorate, listening will be easier if the

mode is set to the MONO position.

* DUAL, also known as DUAL MONO or as BILINGUAL is not currently

transmitted in some countries.

Digital Audio Preference

(DD / MPEG / HE-AAC)

Selects the initial setting for audio tracks.
DD:

The priority is given to Dolby Audio (Dolby Digital).

MPEG:

The priority is given to MPEG. (Australia only)

HE-AAC:

* Dolby Audio (Dolby Digital) is the method of coding digital signals
developed by the Dolby Laboratories. Apart from stereo (2ch) audio, these

The priority is given to HE-AAC. (New Zealand only)

signals can also be multi-channel audio.

* MPEG is an audio compression method that compresses audio to the
smaller size without any considerable loss of audio quality. (Australia only)
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* HE-AAC is a perceptual coding method used to compress digital audio for
efficient storage and transmission. (New Zealand only)

* Not valid in Analogue TV

SPDIF Selection
(Auto / PCM / Dolby Audio)

Selects the initial setting for digital audio output signal from DIGITAL AUDIO
OUT and HDMI2 (ARC function) terminals.

* SPDIF is a standard audio transfer file format.
Auto:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos and HE-AAC multi-channel are output as Dolby Digital
Bitstream. MPEG is output as PCM.

— Dolby Atmos may be output as Dolby Atmos Bitstream, Dolby Digital
Plus and Dolby AC-4 may be output as Dolby Digital Plus Bitstream
from HDMI2 (ARC function) terminal depending on the connected
equipment.

PCM:
Digital output signal is fixed to PCM.
Dolby Audio:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC and AAC are output as Dolby Digital Bitstream or
Dolby Digital Plus Bitstream.

— Dolby Atmos may be output as Dolby Atmos Bitstream from HDMI2
(ARC function) terminal depending on the connected equipment.

* ARC (Audio Return Channel) is a function of digital audio output using
HDMI cable.

* For Digital TV, video content
"M - Media Player > Playback > Audio output settings

"8 - Network > Videos > Audio output settings

HDMI Audio Format

(Auto / Bitstream / PCM)

Selects the audio format for the HDMI input signal.
Auto:

Dolby Audio is output as Dolby Audio Bitstream. Other digital audio
output signals are output as PCM. When the sound is delivered from
theatre speakers, Dolby Audio is output with pass-through method.
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Bitstream:

Dolby Audio is output as Dolby Audio Bitstream. Other digital audio
output signals are output as PCM. When the sound is delivered from
theatre speakers, Dolby Audio is output with transcoding method.

PCM:
Digital audio signal is output as PCM.

PCM Optical Level

Adjusts the audio level of PCM output from DIGITAL AUDIO OUT and HDMI2
(ARC function) terminals to equalise with that of the other audio types.

HDMI Input
(Digital / Analogue)
Selects to fit the input signal.
"8 > Watching > External equipment > HDMI features
Digital:
When sound is carried via the HDMI cable connection
Analogue:
When sound is not carried via the HDMI-DVI adaptor cable connection

e For HDMI
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TV Guide
Using TV Guide

TV Guide - Electronic Programme Guide (EPG) provides an on-screen listing
of the programmes currently broadcast and the forthcoming broadcasts over
the next seven days (depending on the broadcaster).

* Not valid in Analogue TV
1. Select Digital TV with [§Y.
2. Display TV Guide with [E[J][B]=.
(Example)

: 11:30 12:00
DIY 505 Ll

[1] Date / Search(EPG) / Favourites

Time

Programme

[4] Channel position and name
* To watch the programme

1) Select the current programme and press m to access.

2) Select View and press 84 to watch.

— To use Timer Programming
"8 - Watching > TV Guide > Timer Programming

* To the previous day

B (red)
* To the next day

@ (green)
* To view a channel list of the selected type

1) Display the type list with [ (yellow).

2) Select the type and press m to view.
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* To view a channel list of the selected favourite list
"8 - Home > Live TV > Option menu
— To list favourite channels, set Favourites Edit.
"M - Watching > Tuning and editing channels > Favourites Edit
* To view more details of the programme
1) Select the programme.
2) Press to view.
— Press again to return to TV Guide.
* To exit TV Guide

= Note =

¢ When this TV is turned on for the first time, or the TV is switched off for
more than a week, it may take some time before TV Guide is completely
shown.
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Timer Programming

This function allows you to select programmes that you want to record to the
USB HDD.

1. Display TV Guide with [E[J][B]=.
2. Select the forthcoming programme and press m to access.
* To check / change / cancel a timer event
"M - Recording > Timer Programming > Editing Timer Programming
* LED turns to orange in Standby mode when Timer Programming is set.
* Toreturn to TV Guide
RETURN

* |f you select the current programme, a confirmation screen asking
whether you want to watch or record the programme appears. Select
Timer Programming and press m to set USB HDD Rec. to record from
the time you finish the timer event setting.

= Note =
* Not valid in Analogue TV

* Timer Programming only works reliably if correct time information is
received via the signal from the broadcaster or service provider.

* No other channels can be selected while recording of Timer Programming
iS in progress. (Only for single tuner model)

* When recording programmes to the USB HDD, be sure to format the USB
HDD and enable it to record in USB Device Setup.

i“M - Recording > USB HDD setup

* To set timer programming events of this TV on the network equipment
(smartphone, etc.) from outside the home network

"M - Recording > Timer Programming > Remote recording
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Teletext

Viewing Teletext

For New Zealand

1. Switch to teletext with [[=4)-
* Displays the index page (content varies depending on the broadcaster).
» Current / sub page numbers are displayed on the top left of the screen.
* Time / date is displayed on the top right of the screen.

* Colour bar is displayed on the bottom of the screen.

2. Select the page with [@¥EeIdelllilegs, NInllalelelilitess or N B (1

@ (coloured buttons).

EE

EEIE]

DEIED
[N

* To adjust contrast
1) Press I=\l¥] three times to display Contrast.
2) Adjust and press [8J4 to set.

¢ To exit teletext

B Reveal hidden data

. Press [/I=\8].

2. Reveal with [l (red).

* Press again to hide.

-

B To view a favourite page stored
Press to view a favourite page.
 Call up the page stored on [l (blue). (List mode)
* Factory setting is “P103” for Digital teletext, “P801” for Analogue teletext.

m FULL/TOP/BOTTOM
1. Press [JIENU|.

2. Press [ (green) to change the layout.
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B Watch TV and teletext in two windows at once
1. Press =N twice.
2. Set Picture and text to On / Off.

* Operations can be made only in teletext screen.

B Store frequently viewed pages in the colour bar (List mode)
1. Press [l B (] @ (coloured buttons) while the page is displayed.
2. Press and hold 0%,
* The stored page number changes to white.
* To change stored pages
1) Press [l I (] @ (coloured buttons) to change.

2) Enter a new page number with [N[S[g=lg(eRel¥jie]als.

EZE

(] 56

EEIE
©

3) Press and hold [BJ&.

W View sub page

The number of sub pages is displayed on the top of the screen. Press <]/ [»
to view sub page. (Only when teletext has more than one page.)

* The number of sub pages varies depending on the broadcaster (up to
79 pages).

* Searching may take time while you are watching TV.
* To view a specific sub page
1) Press .
2) Press [ (blue).
3) Enter the 4-digit number (e.g. P6, press [0] (0] (0] [6]).
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Teletext mode

For New Zealand

Teletext services are the text information provided by the broadcaster.
* The features may vary depending on the broadcaster.

1. Display the menu with [YI=N[¥].

2. Select Setup > Display Settings > Teletext and press m to access.

3. Select TOP (FASTEXT) / List and press m to set.

B TOP mode (For TOP text broadcasting)

TOP is a particular improvement of the standard teletext service that results in
an easier search and effective guide.

¢ Fast overview of the teletext information available

» Easy to use step-by-step selection of the topical subject

Page status information on the bottom of the screen

Available page up / down

B (red) / I (green)

To select among subject blocks

B (blue)

To select next subject within the subject block

[ (yellow)

(After the last subject, it moves to the next subject block.)

B FASTEXT mode (For FASTEXT broadcasting)

In FASTEXT mode, four differently coloured subjects are situated on the
bottom of the screen.

To access more information about one of these subjects, press the
appropriate coloured button.

This facility enables fast access to information on the subjects shown.

B List mode

In List mode, four differently coloured page numbers are situated on the
bottom of the screen. Each of these numbers can be changed and stored in
the TV’s memory.

"M - Watching > Teletext > Viewing Teletext
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Tuning and editing channels

Setting menu

Some features are not available on all models. Available menu items are displayed on your TV screen.

You can retune channels, create your favourite channel lists, skip unwanted
channels, etc.

1. Select the mode with [,
Satellite TV / Digital TV / Analogue TV
2. Display the menu with .
3. Select Setup > Tuning Menu and press @E to access.

Satellite TV Tuning Menu / Digital TV Tuning Menu / Analogue TV Tuning
Menu

* The menu name varies depending on the TV mode.
4. Select one of the functions and press [8]4 to access.

Favourites Edit / Channel List / Auto Tuning / Manual Tuning / Update
Channel List / New Channel Message / Signal Condition / Add TV Signal

* The function items vary depending on the TV mode.
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Favourites Edit

The favourites lists are available for switching in the information banner and
the TV Guide screen.

M - Watching > Basic > Information banner

"M - Watching > TV Guide > Using TV Guide

M List favourite digital TV channels

Create your favourite channel lists from various broadcasters (up to 4:
Favourites 1 to 4).

1. Select Favourites Edit and press [8J4 to access.
2. Select a channel to list from all digital TV channels.
* [ appears when the channel is encrypted.
* To display other favourites
B (green)
3. Press [8]4 to add it to favourites list.
* To add all channels to the list

[ (yellow)
4. Press JEEIVEY and 0] to store.

B Edit favourites list

You can edit the favourites list while the cursor is on the channel in the
favourites list.

* To move the channel
1) Select the channel.
2) Press [l (green).

3) Select the new position with [@f8[Ele]@elbiilelgs! Or NIFggl=gleNelbiile]gls.

EE

I EIED

MEIE
@

4) Press [l (green) to store.
* To delete the channel
1) Select the channel.
2) Press m to delete.
— Press [ (yellow) to delete all channels.

¢ To name the favourites
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1) Press [l (red).
2) Enter characters (maximum 10 characters) with [@8[le]@e[8lilesE Or

NITEEIEEnE, and press [8]4 to set.

CEE

A EDE]

MEIE
©J

3) Press =183} to store.

= Note =
* Channel numbers are defined by the broadcaster and cannot be changed.

¢ Hidden channels can be selected but not viewed.
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Channel List

B Skip unwanted channels

You can hide (skip) unwanted channels. The hidden channels cannot be
displayed except in this function.

1. Select Channel List and press [8]4 to access.
2. Select a channel.

3. Press [8]4 to set Reveal / Hide (skip).
¥ : Reveal

O : Hide (skip)

* To reveal all channels (if available)

[ (yellow)

B Edit channels
* To swap / move the channel position (if available)
1) Press [l (green) to edit.

2) Set the new position with [@[EeI@elljitelals or (NF[nElileRel¥ite]sls, and press

B (green) to store.

EE

1 E]E]

DEIED
©J

* To retune each channel (Manual Tuning)
B (red)
"% - Watching > Tuning and editing channels > Manual Tuning
* To rename the channel name (Analogue TV)
1) Press [ (blue) to edit.
2) Enter characters (maximum 5 characters) with or

NIENEIENE, and press [84 to set.

CEE

1 EDE]

MEIE
@

3) Press =183} to store.

= Note =
* If a VCR is connected only with the RF cable in Analogue TV, edit VCR.
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Auto Tuning

Some features are not available on all models. Available menu items are displayed on your TV screen.

Automatically retunes the channels received in the area.

* All the previous tuning settings are erased.

» Search begins in the order from the lower channels to the higher channels.

e Child Lock PIN number is required to retune locked channels.

"8 - Functions > Child Lock > PIN number
If tuning has not been done completely, set Manual Tuning.

i“M - Watching > Tuning and editing channels > Manual Tuning

B Satellite TV

1.
2.

Select Antenna System and press [8]4 to access.
Select One LNB / Dual LNB / DISEqC 1.0 and press m to set.
One LNB:
Compatible with single LNB.
Dual LNB:
Up to 2 LNBs can be controlled.
DIiSEqC 1.0:
Up to 4 LNBs can be controlled.

* You can receive several satellites if you have DISEQqC control antenna
system.

e This TV supports DISEqC Version 1.0.

3. Select LNB Configuration and press [8J4 to access.
4. Select LNB / Satellite and set.

1) Set LNB first.

— If you set to One LNB, LNB is not selectable. LNB Power can be set
for the electrical output.

— If you set to Dual LNB, select from LNB AA and AB.
— If you set to DISEqQC 1.0, select from LNB AA, AB, BA and BB.

— If you set to Dual LNB and use 22 KHz switch, set Tone Switch to
On.

2) Set Satellite for the selected LNB.
— Select No Satellite if you do not know the connected satellite.

— Select User defined to set Test Transponder Frequency manually.

5. Press [{=318]34)\ to store.
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6. Select Auto Tuning and press EE to access.
7. Select Search Mode / Scan Mode and press 84 to access.
8. Set the item and press [8]4 to store.
* Scan Mode
Quick:
Scans the suitable frequency for the selected satellite.
Full:
Scans the whole frequency range.
« After settings, select Start scan and press [8]4 to access.
9. A confirmation screen is displayed and press m to access.

10.Select the region and press @E to start Auto Tuning. (Settings are made
automatically.)

* When the operation is completed, the channel at the lowest position will
be displayed.

* If no satellite channel is found, set LNB Band Frequency in LNB
Configuration to suit your environment.

MW Digital TV / Analogue TV
1. Select Auto Tuning and press @E to access.

2. A confirmation screen is displayed and press m to start Auto Tuning.
(Settings are made automatically.)

* When the operation is completed, the channel at the lowest position will
be displayed.

* This setting is applicable only for the selected TV mode.

B Auto Tuning using the buttons on the TV

1. Press and hold INPUT/OK/HOLD for MENU button for 3 seconds to
display the menu.

2. Set Auto Tuning with following control panel buttons.

* Move the cursor / select from a range of options / select the menu item

rall +»fi
vl e

* Access the menu / store settings after adjustments have been made or
options have been set with INPUT/OK/HOLD for MENU button
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Manual Tuning

Some features are not available on all models. Available menu items are displayed on your TV screen.

B Satellite TV

* Please consult the received satellite broadcasting companies for the
setting.

1. Select Transponder Frequency / Symbol Rate / Polarisation / Modulation /

SR D ER K1Y BC ursor buttonsfe]JdNumeric buttonsh

EE

B EIED

DEIE
[N

2. Select Start scan and press 84 to search.

* Depending on the search mode you select in Auto Tuning, this function
may not be available.

m Digital TV

Normally use Auto Tuning or Update Channel List to retune Digital TV
channels.

If tuning has not been done completely or for adjusting the direction of the
aerial, use this function.

 All Digital TV channels found are added to Channel List.
1. Select physical channel and offset.
2. Press [8]4 to search.

B Analogue TV

Set Analogue TV channel manually after Auto Tuning.

1. Select the channel position with [NEgElgleRelifelaks.

EZE

(] 5] (6]

MEIE
[N

2. Select the channel with [@jELEINEIsWABIe\y!.
A
v

3. Set Manual Tuning.
4. Select Store and press 8] to set.

* If a VCR is connected only with the RF cable, select channel position O.
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Update Channel List

Some features are not available on all models.

By updating the channel list of digital broadcasting, you can add new
channels, delete removed channels or change channel names and positions
automatically.

* The channel list is updated while keeping your settings in Favourites Edit,
Channel List, Child Lock, etc.

* Depending on the signal condition, the update may not work properly.

* To update Satellite TV channels, set Search Mode and Scan Mode before
updating.

1) Select Search Mode / Scan Mode and press [8]4 to access.
2) Set each item and press [§J4 to store.
3) After settings, select Start scan and press [8]4 to access.

4) Select the region and press [8]4 to search.
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New Channel Message

For Australia

Selects whether to give a notification message when a new digital TV channel
is found or not.

* When a notification message appears, you can perform Update Channel
List pressing [§J&.

* Sometimes, mainly during summer months at night, the TV may pick up
distant TV stations outside your broadcast due to favourable short term
ionosphere conditions. In such circumstances when you press m the TV
does not add any new channels. This is normal.
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Signal Condition
Selects a channel and checks the signal condition with indicators.
* A good Signal Strength is not an indication of suitable signal reception.

* To change the channel

A
W

* Not valid in Analogue TV
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Add TV Signal
Adds the TV mode.

* Allows you to add any TV mode which was skipped during initial Auto
Tuning.
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Recording

USB HDD setup

Preparations

You can record the digital TV programmes to the connected USB HDD and
enjoy playing back in various ways.

* Prepare the USB HDD for the exclusive use of recording with this TV.

Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting cables.

Connect the USB HDD to the USB 1 or USB 2 port with the USB cable.

(Refer to the terminal indication of TV set.)

Be sure to connect the USB HDD to the mains socket.

* To remove the USB HDD safely from the TV, perform Safely remove USB
in USB Device Setup.

"M - Recording > USB HDD setup > Setting for USB HDD

Check the terminal type and cable plugs are correct for connection.

[ (4]

| —

[1] USB port
USB cable
USB HDD
[4] Mains socket

= Caution =
* All data in the USB HDD will be erased in the following cases:
— When formatting the USB HDD with this TV
"8 - Recording > USB HDD setup > Setting for USB HDD
— When formatting the USB HDD to use on PC, etc.

* When the TV is repaired due to a malfunction, you may have to format
the USB HDD again with this TV to use it. (All data will be erased after
formatting.)

-122 -



* To use the USB HDD with your PC after recording with this TV, format it

again on your PC. (Special operations or tools may be necessary to format
on your PC. For details, read the manual of the USB HDD.)

The data recorded on the USB HDD with this TV can only be played back
on this TV. You cannot play back its content with another TV (including the
TV of the same model number) or any equipment.

Do not turn the TV off, pull out the mains plug or remove the USB HDD
during operation (formatting, recording, etc.). Doing so may cause
malfunction of the device or damage the recorded data. (An electric
outage may also be a cause of malfunction.)

= Note =

Analogue TV programme cannot be recorded on the USB HDD.

The data broadcasting (MHEG, etc.), radio broadcasting are not recorded,
and also the recording function does not work during the period without
any signal.

Not all the programmes can be recorded depending on the broadcaster
and service provider.

You cannot copy the recorded TV programmes of the USB HDD.

The recorded content may not be played back properly depending on the
progress of recording. (Only for dual tuner model)

For details of the USB HDD

"M - Recording > Technical information > USB HDD
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Setting for USB HDD

Format and set up the USB HDD with this TV in order to use it for recording.
All the USB devices recognised as a mass storage device are listed.

¢ Please note that USB HDD will be formatted and all data in it will be
erased after this setup.

» Before setting, connect the USB HDD and be sure to turn on the USB
HDD.

"M - Recording > USB HDD setup > Preparations

1. Display the menu with .
2. Select Setup > USB Device Setup and press m to access.
3. Select the USB HDD for recording and press m to start setup.
* Some USB HDD may not be displayed.
» To display information of the highlighted device
INFO

4. When the caution and confirmation screen for using USB HDD is
displayed, select Yes and press [8]4 to proceed.

5. When a confirmation screen of USB HDD name is displayed, select Yes
and press [8JJ to set.

* The name for the USB HDD is created automatically. If you want to edit
the name, select Yes.

1) Enter characters with [@8glel@elijitegts! or [NVggl=Ti[eNe¥[ite]gls, and press
m to set.

EE

A EIED

DEIE
@

2) Press [J{=0)8]Jx3)\| to store.

6. When a confirmation screen to enable USB HDD for recording is
displayed, select Yes and press [8J4 to set.

* If another formatted USB HDD for recording already exists, this
confirmation screen will be displayed to switch to enable this USB HDD
for recording.
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* Mode of the USB HDD
@ : The USB HDD is available for recording / playing back.

Only one USB HDD on the list is available for recording.
> : The USB HDD is available for playing back.

* To change the mode
OK
* To edit USB HDD name
B (green)
* To format
Bl (red)
* To remove the USB HDD safely from the TV
(3 (yellow)

= Note =
* You can only select one USB HDD for recording at a time.

* You cannot change the settings for the USB HDD while recording is in
progress.
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Recording current programme

One Touch Recording
Records the current programme to the USB HDD immediately.
» Confirm the remote control code is “73”.

"8 - Watching > External equipment > Operating with TV’s remote control

1. Display the menu with \JI=\18).

2. Select Setup > Recording Setup > One Touch Recording and press [§J to
access.

3. Select the maximum recording time 30 /60 /90 /120 / 180 (minutes) and
press m to set.

B To start One Touch Recording
Press [(# ] to start.

» Other channels cannot be selected while recording is in progress. (Only for

single tuner model)

B To stop recording in progress
Press [(= ] to stop.

B To play back or delete the recorded content

Recorded TV programmes can be played back in Media Player.

1. Display Home with [FOIYI=.

2. Select Devices and press (@) to access.

3. Select USB HDD for recording and press [8]4 to access.
"M - Media Player > Recorded TV mode

* Even if One Touch Recording is in progress, you can play back all the
content. (Depending on the USB HDD, playback may not be possible or
the recording may not work properly during playback.)

- 126 -



Timer Programming

Setting Timer Programming

Some features are not available on all models. Available menu items are displayed on your TV screen.

This function allows you to select programmes that you want to record to the

USB HDD.
* Not valid in Analogue TV
1. Select Satellite TV / Digital TV with [
2. Display the menu with [JIENIV).
3. Select Timer > Timer Programming and press EE to access.
4. Press m to start making the settings.
USB HDD Rec.:
Records the programme to the USB HDD.
5. Select and set the item (channel, date, start time, end time).

« [4] and [6] can also be entered with [N\[Fgl=laleRo1tiile1gL.

EZE]

EEIE]

EEIE
[N

(Example)

=

ss % """ s ?HE """ =

[1] !: Overlapped timer events
Function (USB HDD Rec.)
D: Digital TV
S: Satellite TV
[4] Channel position, channel name, etc.
[5] Date
— Daily Sun-Sat: Sunday to Saturday
— Daily Mon-Sat: Monday to Saturday
— Daily Mon-Fri: Monday to Friday

— Weekly Sun/Mon /Tue / Wed / Thu / Fri / Sat: Same time on the

same day every week

[6] Start time / End time / Duration (automatic display)
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6. Store with [0]4.
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Editing Timer Programming

Some features are not available on all models. Available menu items are displayed on your TV screen.

1. Display the menu with [JI=IN[8].

2. Select Timer > Timer Programming and press [8J4 to access.

3. Select the event.
* To change a timer event
OK
— Correct as necessary.
"M - Recording > Timer Programming > Setting Timer Programming
* To delete a timer event
1) Press [l (red).
2) Press [8]4 to delete.

B To adjust the clock

If you cannot get the time information, set Clock Settings manually.
. Display the menu with [JI=\[U].

2. Select Timer > Clock Settings > Mode and press m to access.

-

3. Select Manual and press [8]4 to set.

4. Set Date / Time with [@f8[g&e]@lel¥jitelaks] Or [NSInal=laleReIVjilelgks .

EE

EEIE]

DEIE
[N

* Clock Settings are reset when the TV is turned off with Mains Power On /
Off switch.

"M - Watching > Basic > Adjusting time

B To stop recording

Only for dual tuner model

1. Press [=].

2. Select the programme and press 84 to access (when 2 recordings are in
progress).

3. Select Yes and press [8]4 to stop.
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W To play back or delete the recorded content

Recorded TV programmes can be played back in Media Player.

1. Display Home with [SIeJ¥=.

2. Select Devices and press [8]4 to access.

3. Select USB HDD for recording and press [8]4 to access.
"M - Media Player > Recorded TV mode

* The recorded content may not be played back properly depending on the
progress of recording. (Only for dual tuner model)
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Remote recording

You can set timer programming with the network equipment (smartphone,
etc.) from outside the home network using TV Anytime function.

* Ensure the network connections and network settings are completed.
"% - Network > Network connections
"8 > Network > Network settings

* Set TV Anytime to On to use this function.
"M - Functions > TV Anytime > TV Anytime Settings

* To use TV Anytime function, you need to install the application for
controlling this TV on your smartphone.

"M - Support > FAQs > Detailed information

For the operations, refer to the support information of the application.

= Note =

¢ This function is not available when the TV is turned off with Mains Power
On / Off switch.

¢ Due to network conditions or certain broadcaster restrictions, this function
may not be available.
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Note

* TV Guide may also be used to set timer event.
M - Watching > TV Guide > Timer Programming
* Timer Programming can store up to 15 events.

* Timer Programming only works reliably if correct time information is
received via the signal from the broadcaster or service provider.

* For recording using Timer Programming, the TV must be either on or in
Standby.

* Depending on the progress of recording, analogue channel may not be
selected. (Only for dual tuner model)

* No other channels can be selected while recording of Timer Programming
iS in progress. (Only for single tuner model)

* Recording an encrypted (copy-protected) programme may not be possible.

* When the start time comes, the channel may be switched automatically
and the video and audio signals may be output. 2 minutes before the start
time, a reminder message may appear if you are watching TV. (Only for dual

tuner model)

* When the start time comes, the channel will be switched automatically and
the video and audio signals will be output. 2 minutes before the start time,
a reminder message appears if you are watching TV. (Only for single tuner model)

— To remove the message and start the programming, press [J4.
— To cancel the programming, press .

* LED turns to orange in Standby mode when Timer Programming is set.

“'”

identifies that three or more timer events are overlapped. As for
the overlapped recording events, the first event starts and finishes as
programmed. The next event can then start. (Only for dual tuner model)

* The recording of Timer Programming may automatically change the
channel to the programmed channel a few seconds before the start time.

(Only for dual tuner model)

identifies that two or more timer events are overlapped. As for the
overlapped recording events, the first event starts and finishes as
programmed. The next event can then start. (Only for single tuner model)

* The recording of Timer Programming automatically changes the channel to
the programmed channel a few seconds before the start time. (Only for single

tuner model)
* For details of the USB HDD

"M - Recording > Technical information
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Technical information
USB HDD

m USB HDD
(for recording the digital TV programmes with this TV)
* The capacity of USB HDD that works with this TV is from 160 GB to 6 TB.

* Connect the USB HDD to the mains socket to record and play back
properly with this TV.

* Use the USB HDD formatted with this TV.
"M - Recording > USB HDD setup > Setting for USB HDD

* Regarding performance, not all USB HDDs are guaranteed.

= Note =
» Data modified with a PC may not be displayed.

* Do not remove the device while the TV is accessing data. Otherwise this
can damage the device or TV.

* Do not touch the pins on the device.
* Do not subject the device to a high pressure or impact.

* Insert the device in the correct direction. Otherwise this can damage the
device or TV.

 Electrical interference, static electricity, or erroneous operation may
damage the data or device.
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Media Player

Using Media Player

Information

Media Player allows you to enjoy photo, video or music recorded on the USB
Flash Memory, and content recorded with this TV to the formatted USB HDD.

(Example)

Easy List View:

Still pictures / moving pictures recorded with digital camera or digital video
camera are played back.

Mix Folder View:
All files grouped by folder are displayed.
Recorded TV mode:

(For exclusive USB HDD) TV programmes recorded on the USB HDD with
this TV are played back.

* During the operation, audio signal is output from DIGITAL AUDIO OUT and
HDMI2 (ARC function) terminals. But no video signals are output. To use
HDMI2 with ARC function, connect an amplifier that has ARC function and
set to use theatre speakers.

. Functions > VIERA Link “HDAVI Control™”

* Pictures may not appear correctly on this TV depending on the recording
equipment used.

* Displaying may take some time when there are many files and folders.
» Partially degraded files may be displayed with reduced resolution.
* Picture setting may not work depending on the condition.

* Folder and file names may be different from those on the digital camera or
digital video camera used.
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W To insert or remove the USB Flash Memory

* Depending on the model, it may be necessary to remove the terminal
cover / cable cover before inserting or removing the USB Flash Memory.

Ensure alignment is straight and complete when inserting or removing.

-1

* To remove the USB Flash Memory safely from the TV, perform Safely
remove USB in USB Device Setup.

1) Display the menu with \JI=\18].
2) Select Setup > USB Device Setup and press [8]4 to access.

3) Select the device and press [ (yellow) to set.

= Note =
* To connect the USB HDD
"M - Recording > USB HDD setup
* Check the terminal type and devices are correct for connection.
* For details of the devices
"M - Media Player > Connected device
* For details of supported file formats

"M - Media Player > Supported format
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Selecting device / mode
1. Insert the USB Flash Memory to the TV.
¥ - Media Player > Using Media Player > Information

* To play back content in the USB HDD, ensure the connection and
settings are completed.

"M - Recording > USB HDD setup
2. Display Home with [gl@]\VI=.
3. Select Devices and press m to access.

4. Select the device (USB Flash Memory / USB HDD) and press [8J4 to
access.

5. Select Easy List View / Mix Folder View / Recorded TV and press 8]4 to
access.

Easy List View

"M - Media Player > Easy List View
Mix Folder View

"8 - Media Player > Mix Folder View
Recorded TV

"M - Media Player > Recorded TV mode

6. The thumbnail view is displayed.

(Example)

 To display / hide information of the highlighted content
INFO

= Note =

* Recorded TV is available for content recorded on the USB HDD with this
TV.

» Select the appropriate device and content for playing back each file.

* You can use the following buttons during playback. Confirm the remote
control code is “73”.

- L
(][] (=) (m][n]

"8 - Watching > External equipment > Operating with TV’s remote control
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Easy List View

Selecting file

Still pictures / moving pictures recorded with digital camera or digital video
camera are played back.

Select the file in the thumbnail view and press 84 to start playback.

If a file or folder is edited or renamed by digital camera, digital video
camera, PC, etc., the thumbnail may not be displayed properly.

E : Error display

To sort by month
1) Display the option menu with [@IzaR[®]\|.
2) Select Calendar and press [8]4 to access.

The preview will start when the title / scene is highlighted in the thumbnail
view if it supports a preview. To turn off the preview, set Video Preview to
Off.

1) Display the option menu with [@JgN[®IN.

2) Select & and press 8]4 to access.

3) Select Video Setup > Video Preview and press m to access.
4) Select On / Off and press [8]4 to set.

— Images may not be displayed for an instant in the thumbnail view.
Set the preview Off to solve this.

— This function is available in the thumbnail view.
For details of supported file formats
"8 - Media Player > Supported format
To play back the file

"8 - Media Player > Playback > Playback
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W Settings

1. Display the option menu with SJgi[eIN|.

2. Select & and press [8]4 to access.

3. Select one of the following items and press [8]4 to access.
Play Select / Repeat / Shuffle

4. Set the item and press [8]4 to store.

Play Select

Settings for playback file selection

Repeat
(Folder / File Repeat / Off)
Playback repeat
Folder:
Playback repeat within the selected folder
File Repeat:

Playback repeat of the selected one file

Shuffle
(On / Off)

Files are played back at random.
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Filtering files

You can filter the files as the content type. (Photo / Video)

1.

Display the option menu with [@]zaR[®]\.

2. Select Filter and press m to access.
3.
4. Select OK and press 8]4 to change.

Select Photo / Video and press [8]d to set.

¢ To select the music file

"M - Media Player > Mix Folder View > Filtering files
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Mix Folder View

Selecting file

Displays the thumbnail of all files which are grouped by folder.
Select the folder / file and press m to start playback.

I : Error display

* The preview will start when the title / scene is highlighted in the thumbnail
view if it supports a preview. To turn off the preview, set Video Preview to
Off.

1) Display the option menu with SIgi[eIN|

2) Select & and press [8]4 to access.

3) Select Video Setup > Video Preview and press m to access.
4) Select On / Off and press m to set.

— Images may not be displayed for an instant in the thumbnail view.
Set the preview Off to solve this.

— This function is available in the thumbnail view.
* For details of supported file formats
"M - Media Player > Supported format
* To play back the file
"M - Media Player > Playback > Playback

B Settings

1. Display the option menu with .

2. Select & and press [8]4 to access.

3. Select one of the following items and press m to access.
Play Select / Repeat / Shuffle

4. Set the item and press [8] to store.

Play Select

Settings for playback file selection
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Repeat
(Folder / File Repeat / Off)
Playback repeat
Folder:
Playback repeat within the selected folder
File Repeat:

Playback repeat of the selected one file

Shuffle
(On / Off)

Files are played back at random.
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Filtering files

You can filter the files as the content type. (Photo / Video / Music)

1.

Display the option menu with [@]zaR[®]\.

2. Select Filter and press m to access.
3.
4. Select OK and press 8]4 to change.

Select Photo / Video / Music and press [8]4 to set.
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Sorting files

You can sort the files in alphabetical / date order.
1. Display the option menu with @Jgii[eIN|.

2. Select Sort and press [8]4 to access.

3. Select Alphabet(A...Z) / Alphabet(Z...A) / Date(1...9) / Date(9...1) and press
[6]4 to change.
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Playback
Playback

B Photo playback
<
To the previous photo
>
To the next photo
Vo
Stop
OKE
Switch the playback mode (Single view / Slideshow).
@ (blue):
Rotate
INFORE
Display / hide the operation guide.

:

Return to thumbnail.

W Video / Music playback
<] :
Rewind
>
Fast forward
Vo
Stop
OKE
Pause (displays the time seek bar) / Playback
* To jump to the specified time point
1) Display the time seek bar with m
2) While the time seek bar is displayed
Press <]/ [>:

Search approx. 10 seconds
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Press and hold <]/ [>:
Search rapidly
3) Jump to the specified time point with [J4.
B (red) :
To the previous title / scene / track
B (green):
To the next title / scene / track

:

Display / hide the operation guide.

:

Return to thumbnail.

= Note =
» To set Repeat / Shuffle for playback
"8 - Media Player > Easy List View > Selecting file

"M - Media Player > Mix Folder View > Selecting file
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Slideshow Settings

Set up the settings for Photo mode.

1. Display the option menu with @Jgii[eIN|.

2. Select Slideshow Settings with [6]4.

3. Select one of the following items and press [8]4 to access.
Screen Mode / Interval / Back Ground Music

4. Set the item and press [8]4 to store.

Screen Mode
(Normal / Zoom)
Selects enlarged or normal viewing.

* Depending on the photo size, the photo may not be fully enlarged to fill the
screen (e.g. portrait style picture).

Interval
(Long / Normal / Short)

Selects slideshow interval.

Back Ground Music
(Off / Type1 / Type2 / Type3 / Typed / TypeS / User / Auto)
Selects the background music during Photo mode.
Type1 - 5:
Music files installed on this TV at the factory settings are played back.
Auto:
Music files stored in the current device are played back.
* If there is no available music data, no sound is played back.
User:
Music files in the device registered by yourself are played back.

* If no music files have been registered or the device which had
registered music files is removed, no sound is played back.
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@ To register music
1) Select the music file and press [8]& to access.

* Depending on the condition of the device, select folders until you
reach the desired music file.

2) Select File / Folder and press m to set.
File:
The selected music file is registered.
Folder:

All the music files in the folder which contains the selected music file
are registered.

= Note =
* Picture quality may be degraded depending on the slideshow setting.

* Picture setting may not work depending on the slideshow setting.
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Video Setup

Set up the settings for Video mode.

1.
2.
3.

Display the option menu with [@Jgi[eIN|
Select Video Setup with [0]4.
Select one of the following items and press 84 to access.
Audio Selection / Dual Mono Audio / Subtitle Settings
* Menu items and selectable options vary depending on the content.

Set the item and press [§JJ to store.

Audio Selection, Dual Mono Audio

Selects for selectable sound tracks (if available).

It may take several seconds to change the sound.

e This function is available during playback.

* Dual mono of Dolby Audio (Dolby Digital, Dolby Digital Plus) is not

supported.

Subtitle Settings
Sets the subtitle setting.

* This function is available during playback.

Subtitle:

Displays / hides subtitles (if available).
Subtitle Text:

Selects the font type to display subtitles correctly (if available).
Subtitle Text Size:

Selects the font size of subtitles.
Subtitle Text Colour:

Selects the colour of subtitles.
Subtitle Text Position:

Adjusts the position of subtitles on the screen.
Subtitle Text Delay:

Adjusts the delay time for the subtitles.
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Audio output settings

You can enjoy the multi-channel sound via an amplifier connected to DIGITAL
AUDIO OUT or HDMI2 (ARC function) terminal.

* To confirm or change the current sound status
"% - Media Player > Playback > Video Setup
1. Display the menu with [YI=N[¥].
2. Select Sound > SPDIF Selection and press [8]4 to access.
3. Select Auto / PCM / Dolby Audio and press m to set.

SPDIF Selection
(Auto / PCM / Dolby Audio)

Selects the initial setting for digital audio output signal from DIGITAL AUDIO
OUT and HDMI2 (ARC function) terminals.

 SPDIF is a standard audio transfer file format.
Auto:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos and HE-AAC multi-channel are output as Dolby Digital
Bitstream. MPEG is output as PCM.

— Dolby Atmos may be output as Dolby Atmos Bitstream, Dolby Digital
Plus and Dolby AC-4 may be output as Dolby Digital Plus Bitstream
from HDMI2 (ARC function) terminal depending on the connected
equipment.

PCM:
Digital output signal is fixed to PCM.
Dolby Audio:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC and AAC are output as Dolby Digital Bitstream or
Dolby Digital Plus Bitstream.

— Dolby Atmos may be output as Dolby Atmos Bitstream from HDMI2
(ARC function) terminal depending on the connected equipment.

* ARC (Audio Return Channel) is a function of digital audio output using
HDMI cable.
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Recorded TV mode

Selecting content
* For exclusive USB HDD

* To play back content in the USB HDD, ensure the connection and settings
are completed.

"M - Recording > USB HDD setup
1. Content list of the selected device is displayed in Recorded TV mode.

* Remaining capacity of the selected device is displayed on the top right.
(This value may not be accurate depending on the condition.)

» Content list is displayed as All or Not Viewed.
All
All the recorded TV programmes are listed.
Not Viewed:
Content not played back yet are listed.
* |cons are displayed.

™ : Content not played back yet (Once you play back the content, this
icon will disappear.)

& : Protected content cannot be deleted.

@ : Currently recording (You can play back this recording content.)
&) : Group of content

2. Select the content and press m to start playback.

* If you have stopped the last playback halfway, a confirmation screen
may be displayed to select whether to start from where you stopped
last time or from the beginning.

* |f the content has multiple programmes with different parental ratings,
the highest restriction is applied to the content. Once you unlock the
restriction, all the programmes in the content can be played back.

* For details of supported file formats

"M -+ Media Player > Supported format > Video format
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Watching recorded TV

B Playback
* To operate playback
A\ Manual skip
— Press to skip forward approx. 30 seconds.
— Press and hold to skip backward approx. 15 seconds.
— Australia only
<] : Rewind
[> : Fast forward
%/ : Stop
6]% : Pause / Playback
— The time seek bar is displayed while pausing. (Australia only)
* To jump to the specified time point
1) Display the time seek bar with 0]
2) While the time seek bar is displayed
Press <] /[>:
Search approx. 10 seconds
Press and hold <]/ [> :
Search rapidly
3) Jump to the specified time point with m
— Australia only
* To display / hide the operation guide and information banner
INFO
* To repeat between the starting point “A” and finishing point “B”
B (blue)
(Set “A” and “B” in order.)
— The points are reset by pressing again or by other operations.
— Australia only
* To the previous / next chapter
B (red) / B (green)

— Arecorded content is automatically divided into chapters (approx.
5 minutes for each).

— Australia only
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* To change aspect
"M - Watching > For best picture > Aspect

* To display the subtitle (if available)

* To confirm or change the current status (if available)
"% - Watching > Basic > AV Options

* To return to list
RETURN

= Note =

* The recorded content may not be played back properly depending on the
progress of recording. (Only for dual tuner model)
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Grouping content
1. Select the content to edit and press [l (blue) to tick in the content list.
2. Display the option menu with (®]zal[@]\.

3. Select Create Group / Release Group / Exclude from Group / Change
Protect Status and press m to set.

Create Group:

Create a group of content. Select and tick all the desired content, and
then select Create Group.

Release Group:

Select the created group to release, and then select Release Group.
(To release several groups at once, tick all the desired groups.)

Exclude from Group:

Select the group and press @E to display the grouped content. To
exclude specific content from the group, tick it and then select Exclude
from Group. (To exclude some of the content at once, tick all the
desired content.)

Change Protect Status:

Select the content to protect from deletion, and then select Change
Protect Status. Perform the same way to cancel the protection. (To
change the status of some of the content at once, tick all the desired
content.)
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Deleting content
1. Select the content to edit and press [l (blue) to tick in the content list.

2. Delete the content with [l (red).
3. When a confirmation screen is displayed, select Yes and press (@) to set.
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Chapter List

For Australia
You can start playback from the chapter list you select.
1. Display the chapter list with 3 (yellow).

2. Select the chapter and press m to start playback.

= Note =

* The chapter list is not displayed while the selected content is being
recorded.

* Depending on the recorded programmes, some playback operations may
not work properly.
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Audio output settings

You can enjoy the multi-channel sound via an amplifier connected to DIGITAL
AUDIO OUT or HDMI2 (ARC function) terminal.

* To confirm or change the current sound status
"% - Media Player > Playback > Video Setup
1. Display the menu with [YI=N[¥].
2. Select Sound > SPDIF Selection and press [8]4 to access.
3. Select Auto / PCM / Dolby Audio and press m to set.

SPDIF Selection
(Auto / PCM / Dolby Audio)

Selects the initial setting for digital audio output signal from DIGITAL AUDIO
OUT and HDMI2 (ARC function) terminals.

 SPDIF is a standard audio transfer file format.
Auto:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos and HE-AAC multi-channel are output as Dolby Digital
Bitstream. MPEG is output as PCM.

— Dolby Atmos may be output as Dolby Atmos Bitstream, Dolby Digital
Plus and Dolby AC-4 may be output as Dolby Digital Plus Bitstream
from HDMI2 (ARC function) terminal depending on the connected
equipment.

PCM:
Digital output signal is fixed to PCM.
Dolby Audio:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC and AAC are output as Dolby Digital Bitstream or
Dolby Digital Plus Bitstream.

— Dolby Atmos may be output as Dolby Atmos Bitstream from HDMI2
(ARC function) terminal depending on the connected equipment.

* ARC (Audio Return Channel) is a function of digital audio output using
HDMI cable.
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Other settings
USB Sharing

You can copy the content from one device to another using the USB ports.

¢ To enable this function, connect the source drive and destination drive to

the TV.
"8 - Media Player > Using Media Player > Information

Source drive:

USB device which contains the data to be copied.

Destination drive:

Wb~

USB device to which the data is copied.
Display Apps with .
Select USB Sharing and press m to access.
Select the drive from Source drive and press [8J4 to access.
Select the folder or file to copy and press [l (red) to set.
* To select all folders or files at once
B (green)
Press [> to go to Destination drive.
Select the drive and press m to access.

* You cannot select the source drive as the destination drive.

7. Select Copy Here and press 8]4 to access.

8. When a confirmation screen is displayed, select Yes and press (@l to start

copying.
The copy progress is shown on the top right of the TV screen. When
copying has finished, Complete!! is displayed.

* To cancel the copying, select USB Sharing from Apps again.

* To watch TV while data copying is in progress, press “
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B Create a folder or delete a folder

You can create a new folder or delete an old folder while the cursor is in
Destination drive.

* To create a new folder
1) Display the option menu with SJgi[eIN|.
2) Select Create Folder and press m to access.
3) Enter characters (maximum of 16 characters) with or

NITEEenE, and press [8]4 to set.

EE

I EIED

MEIE
@

4) Press =018\ to store.
* To delete an old folder
1) Select the folder.
2) Display the option menu with .
3) Select Delete and press [8]4 to access.

4) When a confirmation screen is displayed, select Yes and press m to
delete.

= Note =
* Some files may not be copied properly.

* Please note there may be a risk of file corruption due to power failure or
sudden shutdown during USB Sharing process.

* |n consideration of possible loss of the data contained in your USB devices
for any reasons, Panasonic recommends you to store or back up the data
included in the USB devices in other locations (storage mediums) before
inserting the same in the USB port, and please do not turn the TV off
during data communication / transfer.
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Connected device

Device handling caution

Data modified with a PC may not be displayed.

Do not remove the device while the TV is accessing data. Otherwise this
can damage the device or TV.

Do not touch the pins on the device.
Do not subject the device to a high pressure or impact.

Insert the device in the correct direction. Otherwise this can damage the
device or TV.

Electrical interference, static electricity, or erroneous operation may
damage the data or device.

Back up the recorded data at regular intervals to prevent data
deterioration, data damage or erratic operation of the TV. Panasonic is not
liable for any deterioration or damage of recorded data.
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USB devices
* It is recommended to connect the device to the TV’s USB port directly.
* Some USB devices or USB HUB may not be used with this TV.

* You cannot connect any devices using a USB card reader.

B USB Flash Memory
USB Flash Memory format:
FAT16, FAT32 or exFAT

» USB HDDs formatted on a PC are not guaranteed to work in Media Player.

m USB HDD
The capacity of USB HDD that works with this TV is from 160 GB to 6 TB.

Connect the USB HDD to the mains socket to record and play back
properly with this TV.

Use the USB HDD formatted with this TV.

"M - Recording > USB HDD setup > Setting for USB HDD

Regarding performance, not all USB HDDs are guaranteed.
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Supported format

Photo format

B Supported Photo formats

HLG Photo (.hsp)
CTA-2072 standard

Still pictures recorded with HLG standard are supported.

JPEG (jpg, jpeg)
Sub-sampling:
4:4:4, 4:2:2,4:2:0
Image resolution (pixel):
8 x 81030719 x 17 279
DCF and EXIF standards
Progressive JPEG is not supported.

= Note =

Some files may not be played back even if they fulfil these conditions.

Some files may not be played back correctly depending on the resolution,
etc.

Do not use multi-byte characters or other special codes for file names.

Connected devices may become unusable with this TV if the file or folder
names are changed.
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Video format

B Supported Video formats

® AVI (.avi)
Video codec:
H.264, MPEG1, MPEG2, MPEG4, VC-1, WMV9
Audio codec:

AAC, ADPCM, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC,
LPCM, MP3, WMA, WMA Pro

® MP4 (.f4v, .m4v, .mp4)
Video codec:
H.264, H.265 (HEVC), MPEG1, MPEG2, MPEG4
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC, MP3

* This TV supports this container recorded with Panasonic products. For
details, read the manual of the products.

® MKV (.mkv)
Video codec:
H.264, H.265 (HEVC), MPEG1, MPEG2, MPEG4
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC, MP3,
Vorbis

® ASF (.asf, .wmv)
Video codec:
MPEG4, VC-1, WMV9
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC, LPCM,
MP3, WMA, WMA Pro

» Copy-protected files cannot be played back.
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FLV (.flv)
Video codec:
H.264
Audio codec:

AAC, MP3

3GPP (.3gp, .392)

Video codec:
H.264, MPEG4

Audio codec:
AAC, HE-AAC

PS (.mod, .mpg, .mpeg, .vob, .vro)
Video codec:

H.264, MPEG1, MPEG2, VC-1
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC, LPCM,
MP3

TS (.mts, .m2ts, .tp, .trp, .ts, .its)
Video codec:

H.264, H.265 (HEVC), MPEG1, MPEG2, VC-1
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC, MP3

WebM (.webm)

Video codec:
VP9

Audio codec:
Vorbis
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B Supported Subtitles formats

® MicroDVD, SubRip, TMPIlayer (.srt, .sub, .txt)

¢ The video file and subtitles text file are inside the same folder, and the file
names are the same except for the file extensions.

* |f there are more than one subtitles text files inside the same folder, they
are displayed in the following order of priority: “.srt”, “.sub”, “.txt”.

= Note =
* Some files may not be played back even if they fulfil these conditions.

* Some files may not be played back correctly depending on the resolution,
frame rate condition, etc.

* Some subtitles or chapter functions may not be available.
* Do not use multi-byte characters or other special codes for file names.

* Connected devices may become unusable with this TV if the file or folder
names are changed.

» Supported formats are different in Media Player and media server.
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Music format

B Supported Music formats

® MP3 (.mp3)

® AAC /Apple Lossless (.m4a)
» Copy-protected files cannot be played back.

® FLAC (.flac)

e WMA/WMA Pro (.wma)
» Copy-protected files cannot be played back.

® LPCM (.wav)

= Note =
* Some files may not be played back even if they fulfil these conditions.
* Do not use multi-byte characters or other special codes for file names.

* Connected devices may become unusable with this TV if the file or folder
names are changed.
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Network

Internet content

Information

You can access some specific websites supported by Panasonic, and enjoy
internet content such as videos, games, communication tools, etc. from Apps.

(Example)

* A broadband network environment is required to use this function. Ensure
the network connections and network settings are completed.

"M - Network > Network connections

"M - Network > Network settings

B Browser
You can browse websites.

* Some internet services may not be available or may not be displayed
properly depending on the website.
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Selecting internet content
1. Display Apps with .
* For details of Apps
"8 - Home > Apps

* Depending on the usage conditions, it may take a while to read all the
data.

2. Select the desired item and press (@] to access.

(Example)

* To exit Apps

* You can connect a keyboard for character input in the applications. You
can also use the keyboard for TV operation.

"M - Functions > Bluetooth devices

"8 - Functions > Keyboard
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Note

* If you cannot access the internet content, check the network connections
and settings.

"8 - Network > Network connections

"8 - Network > Network settings
* The design and specifications are subject to change without notice.
* Not all the features of the websites are available.

* Be sure to update the software when a software update notice is displayed
on the TV screen. If the software is not updated, you may not be able to
use Apps. You can update the software later manually.

"M - Network > Network settings > Software Update

* The services through Apps are operated by their respective service
providers and such service may be discontinued either temporarily or
permanently without notice. Therefore, Panasonic will make no warranty
for the content or the continuity of the services.

* Content may be presented in specific languages.

* Depending on the connection environment, the internet connection may be
slow or may not be successful.

- 168 -



Home network

In-House streaming
* To enable this function, connect this TV to your home network.
"M - Network > Network connections

"M - Network > Network settings

B Playback of sharing content stored in the media server

Store photo, video or music content into the media server connected to your
home network. And then you can enjoy the content on this TV.

(Example)

4 ;

* For details of watching and operating content on this TV
"8 - Network > Home network > Preparations
* For details of supported file formats

"8 - Network > Supported format

B Playback of sharing content on this TV with the DMC (Digital
Media Controller) network equipment

You can enjoy content stored in the media server by controlling with the DMC
network equipment connected to your home network.

* To use this function with your smartphone or PC, set TV Remote App
Settings of this TV.

"8 - Network > Network settings > TV Remote App Settings

And you need to install the application for controlling this TV on your
smartphone.

"M - Support > FAQs > Detailed information

For the operations, refer to the support information of the application.
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B Sharing the content of this TV with another piece of network
equipment

You can enjoy the content of this TV with another network equipment
connected to your home network.

Available content:

* Photo, video or music content of this TV

e Current digital TV programme

* TV programmes recorded on USB HDDs with this TV
Available network equipment:

* TV supporting home network function

* Smartphone, etc.

* To use this function with your smartphone, you need to install the
application for controlling this TV on your smartphone.

i“¥ - Support > FAQs > Detailed information
For the operations, refer to the support information of the application.

* To use this function with another TV, set Network Link Settings of this TV.
"M - Network > Network settings > Network Link Settings

» Sharing the current programme may not be available when selecting
radio channels, encrypted (copy-protected) programmes, digital satellite
broadcasts or when the broadcast prohibits the output of video and audio.

* Display the TV full-screen for sharing the TV programme with another
piece of network equipment.

* Only 1 piece of other equipment can share the content of this TV.

= Note =

¢ This function is not available when the TV is turned off with Mains Power
On / Off switch.

* This function may not be available in the following condition of this TV:
— While the recording is in progress

» Selecting the channel or TV mode on your smartphone may not be
available while the recording is in progress.
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Preparations

To use in-house streaming features, ensure the preparations of the media
server, network connections and network settings are completed.

"M - Network > Home network > In-House streaming
8 - Network > Network connections
"M - Network > Network settings
1. Display Home with [FIOIYI=.
2. Select Devices and press [8]4 to access.
3. Select the media server and press [8Jd to access.
* To display / hide information of the highlighted media server
1) Display the option menu with [@JNI®IN.
2) Select Show Info. and press m to access.
4. Select the file and press [8]4 to access.

(Example)

* Depending on the condition of media server, you may need to select
the folder before selecting the file.

» To display / hide information of the highlighted file
INFO

= Note =
* Non-playable files are also listed but cannot be selected.

* You can use the following buttons during playback. Confirm the remote
control code is “73”.

Ll
LeaJ (o= (] [m][n]

"M - Watching > External equipment > Operating with TV’s remote control

* Some operations may not be available depending on the content.
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Network connections

Internet connection
A broadband network environment is required to use internet services.

* Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting the LAN cable.

* |f you do not have any broadband network services, please consult your
retailer for assistance.

* Dial-up internet connections cannot be used.

* Required speed (effective): at least 1.5 Mbps for SD (Standard Definition)
and 6 Mbps for HD (High Definition) picture quality, respectively. If the
transfer speed is not enough, content may not be played back properly.

B Wireless connection

[l

)| I ((
J'— \;!l

[1] Built-in wireless LAN (Rear of the TV)
Access point

Internet environment

B Wired connection

[1]
5
8 e O

[1] ETHERNET terminal
LAN cable (Shielded)
* Use Shielded Twist Pair (STP) LAN cable.

Internet environment

-172 -



Home network connection

To use in-house streaming features, you need a home network environment
and you can operate the features without a broadband network environment.

* A broadband network environment is required to use internet services.
"8 > Network > Network connections > Internet connection

* Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting the LAN cable.

B Wireless connection (For home network and internet service)

[l

=
=
N

@
./

S

) (@
i' fe==s I

|
1

[1] Built-in wireless LAN (Rear of the TV)
Access point

Hub / Router

[4] Internet environment

[5] Smartphone, etc.

[6] Media server (PC, etc.)
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B Wired connection (For home network and internet service)

@
./

[1] ETHERNET terminal
LAN cable (Shielded)
* Use Shielded Twist Pair (STP) LAN cable.
Hub / Router
[4] Internet environment
[5] Media server (PC, etc.)
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B Wireless connection (For home network)

=
=

[]

1] Tv

* To use the TV as a wireless access point

"M - Network > Network settings > Custom - Wireless Access Point

Media server (PC, etc.)
Smartphone, etc.
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Note

Ensure to use a LAN straight cable.

Set up and connect equipment required for the network environment. You
cannot make such settings on this TV. Read the manual of the equipment.

If your modem has no broadband router functions, use a broadband router.

If your modem has broadband router functions but there are no vacant
ports, use a hub.

Ensure that the broadband routers and hubs are compatible with
10BASE-T / 100BASE-TX.

If you use the equipment compatible only with 100BASE-TX, category 5 or
later LAN cables are required.

Contact your Internet Service Provider (ISP) or telecommunications
company for further assistance regarding the network equipment.

Confirm the terms and conditions of the contracts with your Internet
Service Provider (ISP) or telecommunications company. Depending on the
contracts, additional fees may be charged or multiple connections to the
internet may be impossible.

Turn the TV off with Mains Power On / Off switch, then turn it on again
when changing or making the network connection again.

Depending on the network condition, the content may not be played back
properly.
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Network settings

Network Connection
Ensure the connections are completed before starting network setup.

"M - Network > Network connections

B Quick setup - Wireless
1. Display the menu with \Ji=\18).
2. Select Network > Network Connection and press [8]4 to access.

» Confirm the encryption key, settings and position of your access point
before starting setup. For details, read the manual of the access point.

3. Select Quick setup and press [8]4 to access.

* When the LAN cable is connected, wired setup will be done
automatically.

4. Select your desired access point and press m to access.

* Available Wireless Networks are displayed automatically.
[l : Encrypted access point

* For WPS(Push button)
1) Select Easy setup with Push button and press m to access.
2) Press the WPS button on the access point until the light flashes.
3) Connect the TV with the access point with @]4.
— WPS: Wi-Fi Protected Setup™

— If the connection fails, check the settings and positions of your
access point. And then, follow the on-screen instructions.

* |tis recommended to select the encrypted access point.

5. Enter the encryption key of the access point and press @E to set.

* You can set characters using NE[alclfleNeIFlilelpk.

EZE

EEIE]

EIED
@

* Press =18/} to store.
6. Automatically setup is done and Network Status is displayed.

"M - Network > Network settings > Network Status
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7. Select Exit and press [8J4 to set.
* To set manually

"M - Network > Network settings > Custom - Wireless

B Quick setup - Wired
. Display the menu with [{I=IN[§].

-_

2. Select Network > Network Connection and press m to access.
3. Select Quick setup and press m to access.
4. Automatically setup is done and Network Status is displayed.
"M - Network > Network settings > Network Status
5. Select Exit and press m to set.
* To set manually

"M - Network > Network settings > Custom - Wired

= Note =

» To deactivate wireless, set Easy Mirroring to Off and confirm the network
connection type is set to Wired.
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Custom - Wireless

Ensure the connections are completed before starting network setup.

"M - Network > Network connections

1. Display the menu with \Ji=\18).

2. Select Network > Network Connection > Custom > Wireless and press [6]J
to access.

Confirm the encryption key, settings and position of your access point
before starting setup. For details, read the manual of the access point.

3. Select your desired access point and press @E to access.

Available Wireless Networks are displayed automatically.

[ : Encrypted access point

For WPS(Push button)

1) Press Il (red).

2) Press the WPS button on the access point until the light flashes.
3) Connect the TV with the access point with m

— WPS: Wi-Fi Protected Setup™

— If the connection fails, check the settings and positions of your
access point. And then, follow the on-screen instructions.

For WPS(PIN)

1) Press [l (green).

2) Enter the PIN code to the access point.

3) Connect the TV with the access point with .

For Manual

1) Press [ (yellow).

2) You can set up SSID, security settings and encryption key manually.
3) Follow the on-screen instructions and set manually.

To search access points again

B (blue)

To display / hide information of the highlighted access point
INFO

It is recommended to select the encrypted access point.

-179 -



4. Enter the encryption key of the access point and press [8]4 to set.

* You can set characters using [NEpElgleRel¥ife]gks!.
EIE]D

[ E]E]
MEED
(@]
* Press {=218I3)\| to store.
5. IP/DNS Settings is displayed.

Acquire IP Address / Acquire DNS Address
* Auto is recommended.
* Available settings are displayed automatically.

* To set manually, select and set IP Address / Subnet Mask / Default
Gateway / DNS Address.

Proxy Settings
* |tis not required for normal household use.

* Some internet services may not be available depending on the proxy
setting.

Proxy:

This is the address of the relay server which is connected between the
browser and the target server to send data to the browser.

1) Select Proxy and press [8J4 to access.

2) Enter the address with [®fi[Elel@eltlitelgts Or (N\[gal=lg[eHelbiitelslS, and

press m to set.

EE

E1E]E]

EEIED
[N

3) Press =183\ to store.
Proxy Port:

This number is also specified by the provider with the proxy address.
1) Select Proxy Port.

2) Enter the number with \[sgl=lgleRel8iile]gts!.

EZE]

(4] 5067

EEIE
[N

3) Press =183\ to store.
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6. Select Network Status and press [8]4 to access.

"M - Network > Network settings > Network Status

7. Select Exit and press [8J4 to set.
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Custom - Wired

Ensure the connections are completed before starting network setup.
"8 - Network > Network connections
1. Display the menu with \Ji=\18).

2. Select Network > Network Connection > Custom > Wired and press 8]4 to
access.

3. IP/DNS Settings is displayed.

Acquire IP Address / Acquire DNS Address
* Auto is recommended.
* Available settings are displayed automatically.

* To set manually, select and set IP Address / Subnet Mask / Default
Gateway / DNS Address.

Proxy Settings
¢ |tis not required for normal household use.

* Some internet services may not be available depending on the proxy
setting.

Proxy:

This is the address of the relay server which is connected between the
browser and the target server to send data to the browser.

1) Select Proxy and press [8J4 to access.

2) Enter the address with [@§[gfe]delllilelgE or NFgl=TleRolbjite]sEs, and

press [0JX to set.

EE

A EIED

DEIE
@

3) Press {=1R8I31)\ to store.

Proxy Port:
This number is also specified by the provider with the proxy address.
1) Select Proxy Port.

2) Enter the number with [\[S]ggl=TgleRelblilelaFs.

EZE

EIEIE]

EIED
[N

3) Press =1R8I31)\ to store.
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4. Select Network Status and press [8]4 to access.

"M - Network > Network settings > Network Status

5. Select Exit and press [8]4 to set.

= Note =

* To deactivate wireless, set Easy Mirroring to Off and confirm the network
connection type is set to Wired.
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Custom - Wireless Access Point

You can use the TV as a wireless access point and connect the network
equipment without an access point.

* Confirm the PIN code, network settings of the equipment before starting
setup. For details, read the manual of the equipment.

1. Display the menu with \JI=\18).

2. Select Network > Network Connection > Custom > Wireless Access Point
and press 8][4 to access.

3. Select Connect to device and press [8]4 to access.
* To set manually, select Change settings (see below).
4. Select and set Push button / PIN code and press [8]4 to access.
Push button:

Set up the equipment for Push button. For details, read the manual of
the equipment.

PIN code:
Enter the PIN code of the equipment.

* |If the connection fails, check the settings and positions of the
equipment. And then, follow the on-screen instructions.

B Change settings

You can set up Network name(SSID), Encryption key, Wireless type and
Channel setting method manually.

Follow the on-screen instructions and set manually.

» Set Reset settings to reset the items for Change settings.

= Note =

¢ You cannot connect the internet service while the TV is set to Wireless
Access Point.

* You can connect up to 7 devices. But the transfer rate varies according to
communication environment or the numbers of connected equipment.

* To confirm the current network settings

"% - Network > Network settings > Network Status
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Network Status

Displays and checks the network status (MAC Address, current network
settings, etc.).

1. Display the menu with [JI=N[¥].

2. Select Network > Network Status and press @E to access.

3. Automatically testing is done and Network Status is displayed.
Try Again:

Performs automatic testing of the network connection for the TV and
displays the current status again.

Status Details:
Displays the detailed network status (SSID, security settings, etc.).

* For information about the network connection, select Help.
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TV Name

Sets your favourite name for this TV.

1. Display the menu with [YI=N[¥].

2. Select Network > TV Name and press m to access.
3. Enter characters and press [8]4 to set.

¢ This name is used as the name of this TV on the screen of the other
network equipment.

* When you use two or more TVs in your network environment, set the
names of the TVs for each.
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TV Remote App Settings

Sets to control the TV with the equipment (smartphone, etc.) connected to
your network.

1. Display the menu with [\U=IN[8].
2. Select Network > TV Remote App Settings and press m to access.
3. Select one of the following items and press [8]4 to access.

TV Remote / Powered On by Apps / Wake on LAN / Wireless LAN / Home
Streaming / Device to upload contents / Delete All Pairings

4. Set the item and press [8]4 to store.

TV Remote
(On / Off)

Enables controlling the TV from the network equipment (smartphone, etc.).

Powered On by Apps
(On / Off)
Enables turning the TV on from the network equipment (smartphone, etc.).

* Depending on the network condition, you may have to turn the TV on with
Standby On / Off switch of the TV’s remote control.

* Changing the default configuration may result in higher energy
consumption of the product.

* LED turns to orange in Standby mode when Powered On by Apps is set to
On.

Wake on LAN / Wireless LAN
(On / Off)

Enables turning the TV on via the LAN cable or wireless LAN using a wake-up
message sent from the network equipment in the home network.

* Changing the default configuration may result in higher energy
consumption of the product.
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Home Streaming
(Always / Only when powered on)

Enables sharing the TV programme and content of this TV with the network
equipment (smartphone, etc.) in the home network.

* Changing the default configuration may result in higher energy
consumption of the product.

e LED turns to orange in Standby mode when Home Streaming is set to
Always.

Device to upload contents

Selects device to upload content from the network equipment (smartphone,
etc.).

Delete All Pairings

Delete the pairing information for all paired devices.

= Note =

¢ This function is not available when the TV is turned off with Mains Power
On / Off switch.

* You need to install the application for controlling this TV on your
smartphone.

"8 - Support > FAQs > Detailed information
For the operations, refer to the support information of the application.
* Depending on the network condition, this function may not be available.

* Depending on the area, this function may not be available. For details,
consult your local Panasonic dealer.
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Network Link Settings
Sets to control the TV with devices connected to the network.
1. Display the menu with [YI=N[¥].
2. Select Network > Network Link Settings and press m to access.
3. Select one of the following items and press [8]4 to access.

Home Network Server / Registration Type / Remote Device List
4. Set the item and press [8]4 to store.

Home Network Server
(On / Off)

Enables sharing the TV programme and content of this TV with the network
equipment (TV, etc.).

¢ To use this function with another TV, select the name of this TV from the
media server list of another TV, and then select the content to share. Also
read the manual of another TV.

* To use this function with your smartphone, you need to install the
application for controlling this TV on your smartphone.

"8 - Support > FAQs > Detailed information
For the operations, refer to the support information of the application.

» Changing the default configuration may result in higher energy
consumption of the product.

e LED turns to orange in Standby mode when Home Network Server is set
to On.

Registration Type
(Auto / Manual)

Selects the type to restrict the access to this TV for each piece of equipment
on the home network.

Auto:

All available equipment on the home network is accessible (maximum
16 pieces of equipment).

Manual:

Sets the restrictions for each piece of equipment in Remote Device List.

Remote Device List

Lists the equipment accessible to this TV on the home network.
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= Note =

* Depending on the area, this function may not be available. For details,
consult your local Panasonic dealer.
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TV Anytime Settings

Settings for watching TV or editing timer programming with the network
equipment (smartphone, etc.) from outside the home network.

"M - Functions > TV Anytime > TV Anytime Settings
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Smart Speaker Settings

Controls this TV such as selecting a channel, changing volume, etc. with the
smart speaker function.

* Ensure the network connections and network settings are completed.
"% - Network > Network connections

"8 > Network > Network settings

1. Display the menu with .
2. Select Network > Smart Speaker Settings and press m to access.
3. Follow the on-screen instructions.

* For the operations, refer to the support information.

"M - Support > FAQs > Detailed information
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Mirroring Settings
Settings for the mirroring function

"8 - Functions > Mirroring > Mirroring Settings
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Control4 Settings

Settings for the Control4 function

1. Display the menu with [YI=N[¥].

2. Select Network > Control4 Settings and press m to access.

3. Select Control4 Discovery / Send Identify and press @E to access.
4. Set the item and press [8]4 to store.

Control4 Discovery
(On / Off)

Enables Control4 mode.

Send Identify
Sends identifying message to Control4 controller.

* This function is available when Control4 Discovery is set to On.

= Note =

* For details of the settings and operations, consult your local Control4
dealer.
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VOD Content Refresh

Selects whether to update the VOD content to the latest even when the TV is
in Standby mode.

1. Display the menu with [{I=\8].
2. Select Network > VOD Content Refresh and press [8J4 to access.
3. Select On / Off and press 8]4 to access.

* Changing the default configuration may result in higher energy
consumption of the product.

* LED turns to orange while updating in Standby mode when VOD Content
Refresh is set to On.
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Software Update

Accesses the specific website to update the TV’s software if any updates are
available.

1. Display the menu with [\U=IN[8].
2. Select Network > Software Update and press (@] to access.
3. Follow the on-screen instructions.

* A broadband network environment is required to use this function.
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New Software Message

Selects whether to give a notification message when new software is found
via network or not.

1. Display the menu with [{I=\8].
2. Select Network > New Software Message and press m to access.

3. Select On / Off and press [8J4 to set.
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Terms of Service and Settings

Displays the terms of service and settings.

1. Display the menu with [YI=N[¥].

2. Select Network > Terms of Service and Settings and press [8]4 to access.

3. Follow the on-screen instructions.
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Photos

Selecting file

Ensure the preparations of the media server, network connections and
network settings are completed.

"8 - Network > Home network > In-House streaming
"M - Network > Network connections
"M - Network > Network settings
1. Display Home with [FIOIYI=.
2. Select Devices and press [8]4 to access.
3. Select the media server and press [8Jd to access.
* To display / hide information of the highlighted media server
1) Display the option menu with [@JgNI®IN.
2) Select Show Info. and press m to access.
4. Select the file and press [8]4 to access.

* Depending on the condition of media server, you may need to select
the folder before selecting the file.

* To display / hide information of the highlighted file
INFO

= Note =

* Non-playable files are also listed but cannot be selected.

-199 -



Viewing photo

B Playback

* To operate Single view
<] : To the previous photo
[> : To the next photo
%/ : Stop (return to list)
]% : Slideshow

* To display / hide the operation guide
INFO

* To rotate 90°
@ (blue)

* To return to list
RETURN
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Using Slideshow
1. Select the file from the thumbnail of photos for the first view.
2. Start Slideshow with [l (red) and BJ&.
* To display / hide the operation guide
INFO

* To pause (return to Single view)

El

e To return to list
RETURN

B Slideshow Settings

Set up the settings for photo file operations on this TV.

1. Display the option menu with SJgIi[eIN|.

2. Select Slideshow Settings and press [8]4 to access.

3. Select one of the following items and press [8]4 to access.
Interval / Repeat / Back Ground Music

4. Set the item and press [8]4 to store.

Interval
(Long / Normal / Short)

Selects slideshow interval.

Repeat
(On / Off)

Slideshow repeat

Back Ground Music
(Off / Type1 / Type2 / Type3 / Typed / Typed)

Selects the background music during Photo mode.
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Videos

Selecting file

Ensure the preparations of the media server, network connections and
network settings are completed.

"8 - Network > Home network > In-House streaming
"M - Network > Network connections
"M - Network > Network settings
1. Display Home with [FIOIYI=.
2. Select Devices and press [8]4 to access.
3. Select the media server and press [8Jd to access.
* To display / hide information of the highlighted media server
1) Display the option menu with [@JgNI®IN.
2) Select Show Info. and press m to access.
4. Select the file and press [8]4 to access.

* Depending on the condition of media server, you may need to select
the folder before selecting the file.

* To display / hide information of the highlighted file
INFO

= Note =

* Non-playable files are also listed but cannot be selected.
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Watching video

B Playback

If you have stopped the last playback halfway, a confirmation screen may be
displayed to select whether to start from where you stopped last time or from
the beginning.

* To operate playback
2 Manual skip (if available)
— Press to skip forward approx. 30 seconds.
<] : Rewind
[>> : Fast forward
%/ : Stop
m : Pause (displays the time seek bar / slow playback) / Playback
* To jump to the specified time point
1) Display the time seek bar with 0]
2) While the time seek bar is displayed
Press <] /[>:
Search approx. 10 seconds
Press and hold <]/ [> :
Search rapidly
3) Jump to the specified time point with m
* To display / hide the operation guide and information banner
INFO
* To the previous content
Bl (red)
* To the next content
B (green)
* To change aspect
1) Display Aspect Selection with .
2) Select the mode and press 84 to set.
Aspect1:
Displays the content in original size.
Aspect2:

Displays the content enlarged without distortion.
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— You can also change the mode by pressing XSi1g=®1]. (Press repeatedly
until you reach the desired mode.)

— Aspect cannot be changed depending on the content.
* To return to list
RETURN
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Video Setup

Set up the settings for video file operations on this TV.

1. Display the option menu with @Jgii[eIN|.

2. Select Video Setup and press m to access.

3. Select one of the following items and press [8]4 to access.

Video Preview / Audio Selection / Dual Audio / Dual Mono Audio / Repeat /
Subtitle Settings

* Menu items and selectable options vary depending on the content.

4. Set the item and press [8] to store.

Video Preview
(On / Off)
Sets to start the preview of the title or scene in the thumbnail view.

* Images may not be displayed for an instant in the thumbnail view. Set the
preview Off to solve this.

Audio Selection, Dual Audio, Dual Mono Audio
Selects for selectable sound tracks (if available).
* It may take several seconds to change the sound.
* This function is available during playback.

* Dual mono of Dolby Audio (Dolby Digital, Dolby Digital Plus) is not
supported.

Repeat
(On / Off)

Playback repeat within the selected file

Subtitle Settings
Sets the subtitle setting.
* This function is available during playback.
Subtitle:
Display / hide subtitles (if available).
Subtitle Text:
Selects the font type to display subtitles correctly (if available).
Subtitle Text Size:

Selects the font size of subtitles.
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Subtitle Text Colour:

Selects the colour of subtitles.
Subtitle Text Position:

Adjusts the position of subtitles on the screen.
Subtitle Text Delay:

Adjusts the delay time for the subtitles.
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Audio output settings

You can enjoy the multi-channel sound via an amplifier connected to DIGITAL
AUDIO OUT or HDMI2 (ARC function) terminal.

* To confirm or change the current sound status
"M - Network > Videos > Video Setup
1. Display the menu with [YI=N[¥].
2. Select Sound > SPDIF Selection and press [8]4 to access.
3. Select Auto / PCM / Dolby Audio and press m to set.

SPDIF Selection
(Auto / PCM / Dolby Audio)

Selects the initial setting for digital audio output signal from DIGITAL AUDIO
OUT and HDMI2 (ARC function) terminals.

 SPDIF is a standard audio transfer file format.
Auto:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos and HE-AAC multi-channel are output as Dolby Digital
Bitstream. MPEG is output as PCM.

— Dolby Atmos may be output as Dolby Atmos Bitstream, Dolby Digital
Plus and Dolby AC-4 may be output as Dolby Digital Plus Bitstream
from HDMI2 (ARC function) terminal depending on the connected
equipment.

PCM:
Digital output signal is fixed to PCM.
Dolby Audio:

Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC and AAC are output as Dolby Digital Bitstream or
Dolby Digital Plus Bitstream.

— Dolby Atmos may be output as Dolby Atmos Bitstream from HDMI2
(ARC function) terminal depending on the connected equipment.

* ARC (Audio Return Channel) is a function of digital audio output using
HDMI cable.
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= Note =

* During the operation, audio signal is output from DIGITAL AUDIO OUT and
HDMI2 (ARC function) terminals. But no video signals are output. To use
HDMI2 with ARC function, connect an amplifier that has ARC function and
set to use theatre speakers.

. Functions > VIERA Link “HDAVI Control™”
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Music

Selecting file

Ensure the preparations of the media server, network connections and
network settings are completed.

"8 - Network > Home network > In-House streaming
"M - Network > Network connections
"M - Network > Network settings
1. Display Home with [FIOIYI=.
2. Select Devices and press [8]4 to access.
3. Select the media server and press [8Jd to access.
* To display / hide information of the highlighted media server
1) Display the option menu with [@JgNI®IN.
2) Select Show Info. and press m to access.
4. Select the file and press [8]4 to access.

* Depending on the condition of media server, you may need to select
the folder before selecting the file.

* To display / hide information of the highlighted file
INFO

= Note =
* Non-playable files are also listed but cannot be selected.
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Playing music

B Playback

To operate playback
<] : Rewind
[> : Fast forward
%/ : Stop
m : Pause (displays the time seek bar) / Playback
To jump to the specified time point
1) Display the time seek bar with 0]
2) While the time seek bar is displayed

Press <]/ [>:

Search approx. 10 seconds
Press and hold <]/ [> :
Search rapidly

3) Jump to the specified time point with m
To display / hide the operation guide
INFO
To the previous track
Bl (red)
To the next track
B (green)
To return to list
RETURN
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Music Setup
Set up the settings for music file operations on this TV.
1. Display the option menu with @Jgii[eIN|.
2. Select Music Setup > Repeat with m
3. Select Off / Folder / One and press [8Jd to set.
Folder:
Playback repeat within the selected folder
One:

Playback repeat of the selected one file
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Supported format

Photo format

B Supported Photo formats

® JPEG (jpg, .jpeg)
Sub-sampling:
4:4:4,4:2:2,4:2:0
Image resolution (pixel):
8 x8t030719 x 17 279
* DCF and EXIF standards
* Progressive JPEG is not supported.

= Note =
* Some files may not be played back even if they fulfil these conditions.
* Do not use multi-byte characters or other special codes for file names.

* Connected devices may become unusable with this TV if the file or folder
names are changed.
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Video format

B Supported Video formats

® AVI (.avi)
Video codec:
H.264, MPEG1, MPEG2, MPEG4, VC-1, WMV9
Audio codec:

AAC, ADPCM, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC,
LPCM, MP3, WMA

® MP4 (.f4v, .m4v, .mp4)
Video codec:
H.264, H.265 (HEVC), MPEG1, MPEG2, MPEG4
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC, MP3

* This TV supports this container recorded with Panasonic products. For
details, read the manual of the products.

® MKV (.mkv)
Video codec:
H.264, H.265 (HEVC), MPEG1, MPEG2, MPEG4
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC, MP3,
Vorbis

® ASF (.asf, .wmv)
Video codec:
MPEG4, VC-1, WMV9
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus), HE-AAC, LPCM,
MP3, WMA

» Copy-protected files cannot be played back.
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FLV (.flv)
Video codec:
H.264
Audio codec:

AAC, MP3

3GPP (.3gp, .392)

Video codec:
H.264, MPEG4

Audio codec:
AAC, HE-AAC

PS (.mod, .mpg, .mpeg, .vob, .vro)
Video codec:

MPEG1, MPEG2
Audio codec:

Dolby Audio (Dolby Digital), LPCM

TS (.mts, .m2ts, .tp, .trp, .ts, .its)
Video codec:

H.264, H.265 (HEVC), MPEG1, MPEG2
Audio codec:

AAC, Dolby Audio (Dolby Digital, Dolby Digital Plus, Dolby AC-4), Dolby
Atmos, HE-AAC

WebM (.webm)

Video codec:
VP9

Audio codec:
Vorbis
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B Supported Subtitles formats

® MicroDVD, SubRip, TMPIlayer (.srt, .sub, .txt)

¢ The video file and subtitles text file are inside the same folder, and the file
names are the same except for the file extensions.

* |f there are more than one subtitles text files inside the same folder, they
are displayed in the following order of priority: “.srt”, “.sub”, “.txt”.

= Note =

* Some files may not be played back even if they fulfil these conditions.

Some subtitles or chapter functions may not be available.

Do not use multi-byte characters or other special codes for file names.

Connected devices may become unusable with this TV if the file or folder
names are changed.

Supported formats are different in Media Player and media server.
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Music format

B Supported Music formats

® MP3 (.mp3)

® AAC /Apple Lossless (.m4a)
» Copy-protected files cannot be played back.

® FLAC (.flac)

® WMA (.wma)
» Copy-protected files cannot be played back.

® LPCM (.wav)

= Note =
* Some files may not be played back even if they fulfil these conditions.
* Do not use multi-byte characters or other special codes for file names.

* Connected devices may become unusable with this TV if the file or folder
names are changed.
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Functions

TV Anytime

How to use

You can watch TV and set timer event with the network equipment
(smartphone, etc.) from outside the home network.

[1] Smartphone, etc.
TV
* Ensure the network connections and network settings are completed.
"M - Network > Network connections

"8 - Network > Network settings

1. Set TV Anytime to On.
"M - Functions > TV Anytime > TV Anytime Settings

2. Connect the device (smartphone, etc.) to the home network and access to
the TV.

* You need to install the application for controlling this TV on your
smartphone.

"M - Support > FAQs > Detailed information

For the operations, refer to the support information of the application.

= Note =

¢ This function is not available when the TV is turned off with Mains Power
On / Off switch.

¢ Due to network conditions or certain broadcaster restrictions, this function
may not be available.
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TV Anytime Settings

1. Display the menu with [JJEN[V].

2. Select Network > TV Anytime Settings and press m to access.
3. Select one of the following items and press [8]4 to access.

TV Anytime / Powered on by Swipe & Share / Device ID / Device
Password

4. Follow the on-screen instructions.

TV Anytime
(On / Off)

Enables watching TV and setting timer event with the network equipment
(smartphone, etc.) from outside the home network.

* Changing the default configuration may result in higher energy
consumption of the product.

* LED turns to orange in Standby mode when TV Anytime is set to On.

Powered on by Swipe & Share
(On 1 Off)

Enables turning on the TV automatically when the Swipe & Share function is
activated from the other devices (smartphone, etc.).

* Set TV Anytime to On to use this function.

* Use the Swipe & Share function to turn on the TV only when you can see
the status of the TV.

Device ID

Displays the device ID of this TV.

Device Password

Displays the device password of this TV.

-218 -



Mirroring

How to use

You can watch and display images of other devices (smartphone, etc.) on the
TV screen using a mirroring function.

[1] Smartphone, etc.
TV
1. Display Home with [gl@)\YI=.

2. Select Devices and press [8]4 to access.
3. Select Mirroring and press m
4. Follow the on-screen instructions.

* Pairing information of the device (smartphone, etc.) is registered once you
use this function.

B Easy Mirroring

You can also start the mirroring function from the other devices (smartphone,
etc.) when Easy Mirroring is set to On.

"M - Functions > Mirroring > Mirroring Settings

* You cannot use Easy Mirroring function while the TV is set to Wireless
Access Point.

"M - Network > Network settings > Network Status

= Note =

* This function is available with the other devices (smartphone, etc.)
supporting the mirroring function. For details, refer to the operating
instructions of the devices.
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Mirroring Settings
You can set items for the mirroring function.
1. Display the menu with [YI=N[¥].
2. Select Network > Mirroring Settings and press m
3. Select one of the following items and press [8]4 to access.
Easy Mirroring / Powered On by Easy Mirroring / Delete All Pairings
4. Set the item and press [8]4 to store.

Easy Mirroring
(On / Off)

Enables starting the mirroring function from the other devices (smartphone,
etc.) without operating the TV.

* To deactivate wireless, set Easy Mirroring to Off and confirm the network
connection type is set to Wired.

"M - Network > Network settings > Network Status

* Not valid when the TV is set to Wireless Access Point

Powered On by Easy Mirroring
(On / Off)

Enables turning on the TV automatically when the mirroring function is
activated from the other devices (smartphone, etc.).

* Changing the default configuration may result in higher energy
consumption of the product.

* Use the mirroring function to turn on the TV only when you can see the
status of the TV.

* Register the devices (smartphone, etc.) before using this function.

e LED turns to orange in Standby mode when Powered On by Easy
Mirroring is set to On.

Delete All Pairings

Delete the pairing information for all paired devices.
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Multi Window

Information

Only for dual tuner model

Displays two windows at once for viewing the TV programmes or external
input (AV / COMPONENT / HDMI) as shown below (example).

Pre-view Pre-view

¢ Pre-view is not available for OLED TV.

* To swap windows

— Not valid while recording is in progress

¢ To exit multi window
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How to use

Only for dual tuner model

You can select a channel while watching another programme or external
input.

1. Display Apps with .
2. Select Multi Window and press [8]4 to access.

B Pre-view

(Example)

[1] Main screen
TV mode / Input mode / Channel position and name (for main screen)
TV mode / Input mode (for sub screen)
— Press <]/ [> to select the TV mode / input mode of the sub screen.
[4] Current programme information (if available) (for sub screen)
— Press A /W to select the programme of the sub screen.
[5] Sub screen / information screen
— Press [ (blue) to change the screen.
* The sound comes only from the main screen.

* Pre-view is not available for OLED TV.
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B Dual view

(Example)

[1] Main screen
TV mode / Input mode / Channel position and name
Sub screen
* Press <]/ [> to select the screen to operate.
— [E4 displays on the screen.
* To select the sound
1) Display the option menu with [@JgNI®IN.
2) Select Sound Output and press m to access.
3) Select Main / Sub and press [8]4 to set.
- displays on the screen.
* To confirm or change the current status

— Menu items and selectable options vary between the main screen and
sub screen.

"M - Watching > Basic > AV Options
* To display / hide the operation guide
INFO
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Note

Only for dual tuner model

This function may not work properly depending on the signal format.
Not valid in Analogue TV

Data services are not available in multi window.

You cannot change the aspect ratio in multi window.

External input mode can only be displayed either on the main screen or
sub screen.

HDMI is available for the main screen.
Some signals are reformatted for suitable viewing on your display.

Playback in fast-forward or in reverse on the sub screen may affect the
picture quality on the main screen.
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VIERA Link “HDAVI Control ™"
Summary of VIERA Link

Enjoy additional HDMI Inter-Operability with Panasonic products which have
“‘HDAVI Control™” function.

VIERA Link (HDAVI Control) connects the TV and the equipment with

VIERA Link function, and enables easy control, playback, energy saving,
creating home theatre, etc. without complicated settings. Connections to the
equipment (DVD Recorder, HD Video Camera, Player theatre, Amplifier, etc.)
with HDMI cable allow you to interface them automatically. These features are
limited to models incorporating “HDAVI Control” and “VIERA Link”.

e This TV supports “HDAVI Control 5” function.

* Some functions are not available depending on the equipment’s version
of HDAVI Control. Confirm the connected equipment’s version of HDAVI
Control.

* VIERA Link “HDAVI Control” is a unique function that we have developed
and added based on the control functions provided by HDMI which is an
industry standard known as HDMI CEC (Consumer Electronics Control).
As such, its operation with other manufacturers’ product that supports
HDMI CEC cannot be guaranteed.

* VIERA Link features may be available even with other manufacturers’
equipment supporting HDMI CEC.

* Please refer to individual manuals for other manufacturers’ product
supporting VIERA Link function.

* About applicable Panasonic product, consult your local Panasonic dealer.
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B VIERA Link (HDMI connection)

* Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting cables.

* Use a fully wired HDMI compliant cable.
* Use a high speed HDMI cable for high resolution images.

* Connect the equipment supporting VIERA Link to the TV’s HDMI terminal
via an HDMI cable.

About HDMI cable for connecting Panasonic HD Video Camera or LUMIX
Camera, read the manual of the equipment.

[1] HDMI terminal
HDMI cable

Equipment with VIERA Link function (DVD Recorder / DVD Player / Blu-
ray Disc Player / HD Video Camera / LUMIX Camera)
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W Available features (HDMI connection)

DVD Recorder / DVD Player / Blu-ray Disc Player
* Easy playback

¢ Power on Link

Power off Link

Standby Power Save*?
Intelligent Auto Standby*?
VIERA Link Control*’

HD Video Camera / LUMIX Camera
* Easy playback
* Power on Link
* Power off Link
* VIERA Link Control*’

*1: For equipment which has “HDAVI Control 2 or later” function.
*2 . For equipment which has “HDAVI Control 4 or later” function.
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B VIERA Link (HDMI and Audio out connections)

Depending on the model, it may be necessary to remove the terminal
cover / cable cover before connecting or disconnecting cables.

Use a fully wired HDMI compliant cable.

Connect the equipment supporting VIERA Link to the TV’s HDMI terminal
via an HDMI cable.

Use the optical digital audio cable for audio output from the TV.

[

|

L R

[1] HDMI terminal

HDMI cable

HD Video Camera / LUMIX Camera with VIERA Link function
[4] HDMI terminal / DIGITAL AUDIO OUT

[5] HDMI cable (Optical digital audio cable*)

[6] Player theatre / Blu-ray Disc theatre with VIERA Link function
Speaker system

Amplifier with VIERA Link function

[9] DVD Recorder with VIERA Link function

* : If the connected equipment has “HDAVI Control 5” function, you do not
have to use this audio cable (Optical digital audio cable). In this case,
connect the equipment to the TV’'s HDMI2 terminal via an HDMI cable.

- 228 -



B Available features (HDMI and Audio out connections)

Player theatre
» Easy playback*?

¢ Power on Link

Power off Link
Intelligent Auto Standby*2*4
VIERA Link Control*

Speaker Selection

Blu-ray Disc theatre
» Easy playback*?

* Power on Link

Power off Link

Standby Power Save*?
Intelligent Auto Standby*2*
VIERA Link Control*’

Speaker Selection

Amplifier
* Power off Link
* Intelligent Auto Standby*?

* Speaker Selection

*1 . For equipment which has “HDAVI Control 2 or later” function.
*2 . For equipment which has “HDAVI Control 4 or later” function.
*3 : While playing a disc

*4 . Except for watching a disc
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B VIERA Link Control of compatible equipment

The following is the maximum number of compatible equipment that can be
controlled by VIERA Link Control. This includes connections to equipment
already connected to the TV.

For example, DVD Player connected to Amplifier which is connected to the TV
via an HDMI cable.

- Functions > VIERA Link “HDAVI Control™” > VIERA Link Control

Recorder:

Maximum 3

Player:

Maximum 3 (DVD Player, Blu-ray Disc Player, HD Video Camera,
LUMIX Camera, Digital Camera, Player theatre, Blu-ray Disc theatre,
etc.)

Audio system:

Maximum 1 (Player theatre, Blu-ray Disc theatre, Amplifier, etc.)
e Tuner:

Maximum 4 (Set top box, etc.)
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Preparations

Connect the equipment supporting VIERA Link.

For details of VIERA Link connections

"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link
Use a fully wired HDMI compliant cable.

Set up the connected equipment. Read the manual of the equipment.
Set VIERA Link to On in the Setup Menu.

Set up the TV. After connection, turn the equipment on and then switch the
TV on. Select the HDMI input from Input Selection with Y and make sure
that an image is displayed correctly. (This setup should be done each time
the following conditions occur.)

— First time operation
— Adding or reconnecting equipment

— Changing setup
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Easy playback

Automatic input switching - When the connected equipment is operated, the
input mode is switched automatically.
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Power on Link
Set Power on Link to On in VIERA Link Settings to use this function.

When the connected equipment is operated, the TV is automatically turned
on. (Only when the TV is in Standby mode.)
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Power off Link
Set Power off Link to On in VIERA Link Settings to use this function.

When the TV is set to Standby mode, the connected equipment is also
automatically set to Standby.
* This function will work even if the TV enters Standby mode automatically
by auto power standby function.
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Standby Power Save
Set Standby Power Save to On in VIERA Link Settings to use this function.

The power consumption of the connected equipment in Standby mode is
controlled higher or lower in synchronisation with the TV on / off state to
reduce the consumption.

When the TV is set to Standby mode, the connected equipment is
automatically set to Standby and the power consumption of the connected
equipment is automatically minimised.

When the TV is turned on, the connected equipment is still in Standby mode,
but the power consumption is increased to quickly start the connected
equipment.

* This function is effective if the connected equipment can change the power
consumption in Standby mode and is set to higher consumption.

¢ This function works when Power off Link is set to On.
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Intelligent Auto Standby
Set Intelligent Auto Standby to On in VIERA Link Settings to use this function.
When the TV is on, non-used connected equipment goes into Standby mode

automatically to reduce the power consumption. For example, when the input
mode is switched from HDMI or when Speaker Selection is changed to TV

(except for watching a disc).

* This function may not work properly depending on the connected
equipment. In this case, set to Off.
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VIERA Link Control

You can control some functions of the connected equipment with this TV’s
remote control by pointing at the TV’s signal receiver.

1. Display Apps with N8

2. Select VIERA Link and press (0])( to access.

3. Select VIERA Link Control and press EE to access.

4. Select one of the following items and press m to access.

Recorder / Player / Home Cinema / Video Camera / LUMIX / Digital
Camera / Other

(The menu of the accessed equipment is displayed. The input mode is
changed automatically.)

* The displayed item may vary depending on the connected equipment.

* Home Cinema means Player theatre, Blu-ray Disc theatre or Recorder
theatre.

e Other means Tuner set top box.
5. Follow the on-screen instructions to operate the menu of the equipment.
» Confirm the remote control code is “73”.
"8 - Watching > External equipment > Operating with TV’s remote control
* To display the operation guide
OPTION

(If other manufacturers’ product is accessed, Setup / Contents
Selection menu may be displayed.)

* Available TV’s remote control buttons depend on the connected
equipment.

B |f multiple recorders or players are connected

Each recorder / player is numbered. The number is given from the TV’s
lower number of HDMI terminal connected to the same type of equipment.
For example, when two recorders are connected to HDMI2 and HDMI3, the
recorder connected to HDMI2 is displayed as Recorder1, and the recorder
connected to HDMI3 is displayed as Recorder2.

B If you access non-VIERA Link equipment

The type of the connected equipment is displayed. Although you can access
the connected equipment, you cannot operate it. Use the remote control of
the connected equipment.
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= Note =

* |f you cannot operate the equipment, check the settings and the
equipment.

"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link

* Some operations may not be available depending on the equipment. In
this case, use the remote control of the connected equipment.

* For details of the operations for the connected equipment, read the
manual of the equipment.

- 238 -



Speaker Selection

You can control the theatre speaker with this TV’s remote control by pointing
at the TV’s signal receiver.

1. Display Apps with N8
2. Select VIERA Link and press (0])( to access.
3. Select Speaker Selection and press 8]4 to access.
4. Select TV / Home Cinema and press [8Jd to set.
TV:
TV speakers are active.
Home Cinema:

The sound is delivered from theatre speakers. Player theatre, Blu-
ray Disc theatre or Amplifier will be automatically turned on if it is in
Standby mode.

* The sound of TV speakers is mute. When the equipment is turned
off, TV speakers will be activated.

* You can use Yel[F[i=N0/ WAL\l and \ISAI=.

B Multi-channel sound

If you want to enjoy the multi-channel sound (e.g. Dolby Audio (Dolby Digital)

5.1ch) via an Amplifier, connect it with an HDMI cable and Optical digital audio
cable, and then select Home Cinema. If your Amplifier has the “HDAVI Control
5” function, you only need to connect it with an HDMI cable to the TV's HDMI2

terminal.

To enjoy multi-channel sound from DIGA Recorder, connect an HDMI cable
from the DIGA Recorder to the Amplifier.

= Note =
* |If you cannot operate the equipment, check the settings and the
equipment.

"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link

* Some operations may not be available depending on the equipment.
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Note

* These functions may not work properly depending on the connected
equipment.

* Image or sound may not be delivered for the first few seconds when the
input mode is switched.

* “HDAVI Control 5” is the newest standard for HDAVI Control compatible
equipment. This standard is compatible with conventional HDAVI
equipment.

¢ To confirm the HDAVI Control version of this TV

"8 - Support > Help menu > Using Help menu

- 240 -



Child Lock
Using Child Lock

You can lock specific channels / AV input terminals to restrict access to them.
When the locked channel / input is selected, a message appears. Enter the
PIN number to watch.

1. Display the menu with [YI=N[¥].
2. Select Setup > Child Lock and press @E to access.
3. Enter the PIN number (4 digits) with [T eRe oS-
OEIE]
(6D

EIE
@

* “0000” has been stored as the default PIN number.
4. Select Child Lock List and press EE to access.
5. Select the channel / input and press m to lock.
* f@& appears when the channel / input is locked.
* To cancel
1) Select the locked channel / input.

2) Press [§J&.

¢ To lock all
B (green)

¢ To cancel all locks

[ (yellow)

* To jump to the head of the next channel / input group

@ (blue)

B Show Adult App
Set to Off to lock specific applications to restrict access to them (if available).
= Note =

¢ For internet content

W Player PIN Control

Applies access control for some digital text services.
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= Note =
e For Digital TV

* New Zealand only
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PIN number
You can change the PIN number.
1. Select Change PIN and press [8]4 to access.
2. Enter a new PIN number twice with [N[§[gElgleRe]bjie]als.
EIE]D
EEE
MEIED
(@]

= Note =

» Setting Shipping Condition erases the PIN number and all settings.

* |f you have forgotten your changed PIN, input “6969” as the PIN number.
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Parental Rating

To watch the digital TV programme that has rating information on the selected
age, enter the PIN number (depending on the broadcaster).

1. Select Parental Rating and press [8]& to access.

2. Select an age for the restriction of programmes and press [8]4 to set.

B Meaning of rating

For Australia
No Block: Not classified

R: Restricted 18+

AV 15+: Adult strong Violence 15+
MA 15+: Mature Adult 15+

M: Mature

PG: Parental Guidance recommended
G: General

C: Children

P: Pre school

For New Zealand
No Block: Not classified

AO: Adults Only

PGR: Parental Guidance Recommended

G: General

= Note =
» Setting Shipping Condition erases the PIN number and all settings.

* |If you have forgotten your changed PIN, input “6969” as the PIN number.
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Power LED Indicator

Using Power LED Indicator

Selects the power LED indication mode.

1.
2,
3.
4,

Display the menu with [JI=NE].
Select Setup > Other Settings and press @E to access.
Select Power LED Indicator and press 8]4 to access.
Select On / On(Standby Only) / Off and press m to set.
On:

The power LED indicator illuminates continuously.
On(Standby Only):

The power LED indicator illuminates only when the TV is turned off with
Standby On / Off switch of the TV’s remote control.

Off:

The power LED indicator is turned off.

= Note =

* The power LED indicator may light when switching the TV status or

activating some functions.

* The TV may not display any image on the screen depending upon the

input source after setting. This may make it impossible to know whether
the TV is turned on or not.

In particular, when Off is selected, notifications whilst the TV is in standby,
cannot be provided, such as USB recording in progress. If a USB device in
recording is removed accidentally in such a condition, a device malfunction
or data destruction may result.
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Data Service Application

Using Data Service Application

You can enjoy Hybrid Broadcast Broadband TV application that may be
provided via digital broadcasting as interactive data services.

1. Display the menu with \U=IN[8].

2. Select Setup > Data Service Application > Service and press EE to
access.

3. Select Auto Start / Manual Start / Off for each channel.
Auto Start:
Automatically starts the application.
Manual Start:
Starts the application by pressing [l (red).
* To sort channel names in alphabetical order
B (red)
* To set Auto Start for all channels
B (green)
* To disable the service for all channels
[ (yellow)
* To set Manual Start for all channels
@ (blue)
4. Press [J{=0R8I})\ to store.

* A notification message will appear when the application is available.
Follow the on-screen instructions.

. is displayed on the information banner if the programme has Hybrid
Broadcast Broadband TV application.

"M - Watching > Basic > Information banner

* To terminate the running application. (The default application may start
immediately.)
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Privacy Setting
1. Display the menu with .

2. Select Setup > Data Service Application > Privacy Setting and press m to
access.

3. Select Low / High / Custom and press [8]4 to set.

B To change the privacy settings manually

You can set up the detailed privacy settings when Privacy Setting is set to
Custom.

Store Cookie
(On / Off)

Enables storing the technical information that a data service application
leaves into the TV in order to recognise to use it again.

Delete Cookie

Deletes all of technical information left by a data service application.

Do Not Track Setting
(Mode1 / Mode2 / Mode3)

Sets to notify websites and some applications about tracking your browsing
activities.

Mode1:

Notifies websites that you want to be tracked.
Mode2:

Notifies websites that you do not want to be tracked.
Mode3:

Sends no configuration information about tracking.

Allow Unique Device ID
(On / Off)
Sends identifying ID of this TV for the data service application.

Reset Unique Device ID
Resets the identifying ID of this TV.
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Note

* Abroadband network environment is required to fully use Hybrid
Broadcast Broadband TV application. Ensure the network connections and
network settings are completed.

N Network > Network connections
"M - Network > Network settings

* Not all the data services are available depending on the area and
broadcaster.

¢ Not valid in multi window mode

* Depending on the connection environment, the internet connection may be
slow or may not be successful.

* Operations may vary depending on the broadcaster. Follow the on-screen
instructions.

* On-screen instructions may not correspond to the remote control buttons.
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Shipping Condition
Shipping Condition

Resets the TV to its original condition (i.e. no channels tuned in).

All settings other than USB Device Setup are reset (channels, picture, sound
settings, etc.).

1. Display the menu with [\U=INE].

2. Select Setup > System Menu > Shipping Condition and press m to
access.

3. When a confirmation screen is displayed, select Yes and press m to set.
4. Follow the on-screen instructions.

* Auto Tuning automatically starts.

* To retune TV channels only (e.g. after moving house), set Auto Tuning.

"M - Watching > Tuning and editing channels > Auto Tuning
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Updating the TV Software

Information

A new version of software may be released for download to enhance the
performance or operations of the TV.

If there is an update available and the channel has the update information, a
notification message is displayed.

¢ To download

— Press when not downloading.
* To update via the internet

"M - Network > Network settings > Software Update

= Note =
» Software updating may result in higher energy consumption of the product.
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Auto update

You can update new software automatically.

1.
2.

Display the menu with \I=IN[8].

Select Setup > System Menu > System Update > Auto Update Search in
Standby and press m to access.

Select Immediately / 1 hour after / Off and press 84 to set.

If System Update is performed, the software will be updated (TV functions
may be changed). If you do not want to do so, set Auto Update Search in
Standby to Off.

Every time you set, the TV automatically performs search in Standby and
downloads an update if any software updates are available.

The automatic updating cannot be performed in the following conditions:
— TV turned off with Mains Power On / Off switch

— Recording is in progress.

= Note =

* Download may take a few hours.
* During software download and update, DO NOT switch off the TV.

* A notification message may be a reminder. In this case, schedule

information (the date when the new version can be used) will appear. You
can set the reservation for update. The update will not start when the TV is
off.
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Manual update
You can update new software manually.
1. Display the menu with [{I=\8].

2. Select Setup > System Menu > System Update > System Update Search
Now and press m to access.

3. Searches for an update (for several minutes) and displays a corresponding
message if any.

4. Download with [6J&.

= Note =
* Download may take a few hours.
* During software download and update, DO NOT switch off the TV.
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Setting characters

Using Numeric buttons

You can enter characters for free input items using [NV R NCes.
Press NI e repeatedly until you reach the desired character.
@1 () %&?,:=8[]~<>{}] A\
rabc2ABC

:def3DEF

:ghidGHI

k15 JKL

:mno6MNO

pqrs7PQRS

:tuv8TUYV

TWXYyz9WXYZ

: Space 0

FEEFNECOEENE

* The character is set automatically if you leave for 1 second.

* You can also set the character pressing 84 or other NI N ELs less
than 1 second.

* The characters may vary depending on the input item.
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Bluetooth devices
Bluetooth Setup

You can use Bluetooth keyboards*!, Bluetooth mouses*' and Bluetooth audio
devices*? (headphones, smartphone, etc.) with this TV by setting Bluetooth
Setup in the Setup Menu.

*1 : HID (Human Interface Device Profile) and HOGP (Human interface
device Over Generic attribute Profile) compliant keyboards and mouses
can be used.

*2 : A2DP (Advanced Audio Distribution Profile) and AVRCP (Audio Video
Remote Control Profile) compliant audio devices can be used.

1. Display the menu with [YI=\N[¥].

2. Select Setup > Bluetooth Setup and press m to access.

3. Select one of the following items and press [8]4 to access.
Devices / Bluetooth Audio Mode Setting / Bluetooth Audio Settings

4. Set the item and press m to store.

Devices
Searches the available device and displays the status.
* Place the device within 50 cm from the TV while registration is in progress.

* Turn the device on for registering. The setup for registration may be
required depending on the device. Read the manual of the device.

* You cannot use two or more A2DP compliant audio devices
simultaneously.

Not paired:

The device is not registered. Register the device by following the on-
screen instructions to use with this TV.

Connected:
The device is registered and you can use with this TV.
Not connected:

The device is already registered, but not connected to this TV. Check
the device is turned on and set within the available range.

Bluetooth Audio Mode Setting
(Transmitter / Receiver)

Selects the TV’s Bluetooth audio mode.
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Transmitter:
Connects an audio device such as headphones, speaker, etc.
Receiver:

Connects an audio device such as a smartphone, audio player, etc.

Bluetooth Audio Settings
Adjusts the volume for an audio device, etc. in the transmitter mode.
Audio Output:

Sets to Bluetooth only to mute the TV speakers automatically when
using a Bluetooth audio device. And you can adjust the volume of the

(YT HIETalel\/Olume Up / Down

Volume:
Adjusts the volume of a Bluetooth audio device.
Audio Control:
Sets to control a Panasonic Bluetooth audio device with this TV.

» Settings on a Panasonic Bluetooth audio device are also required to
use this audio control function.

» Settings in the Sound Menu may not be effective for the Bluetooth audio
devices.

* To use Audio Link
1) Display Apps with [N
2) Select Audio Link and press [8J4 to access.
3) Follow the on-screen instructions.

* |If using the 2.4 GHz band on the wireless router, simultaneous use with
Bluetooth device may result in connection interruptions. If your wireless
router supports 5 GHz band, try using the 5 GHz band. If you have a wired
LAN connection, try using the wired LAN connection.

* |f the sound interruption occurs, place Bluetooth device closer to the TV.

* When a Bluetooth device is connected to the TV, it is possible that the
Bluetooth audio output may not be synchronised (i.e. be delayed) with
relation to the images on the screen. This is not a defect of the TV or the
device. The delay time will differ depending on the device.
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Keyboard
Keyboard

» Keyboards requiring the drivers are not supported.

* Characters may not be displayed correctly on the TV screen depending on
the connected keyboard.

* Some of the keys of keyboards may correspond to the operation of the
remote control.

Keyboard Remote Control
1 —1— NI <>
Enter OK
Backspace RETURN
Esc EXIT
0 - 9/ Character Numeric buttons
F1 HOME
F2 APPS
F3 MENU
F4 AV
F5/F6 Channel Down / Up
F7/F8 Volume Down / Up
FO/F10/F11/F12 Coloured buttons
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Settings

Setting menu

How to use

Various menus allow you to make settings for the picture, sound and other
functions.

1. Display the menu with [J[=N[¥).

* Displayed items vary depending on the input signal.
2. Select the menu and press @E to access.
3. Select the items and press [8]4 to access.

* Only available items can be selected.

* You can also access from eHELP pressing [l (red) at each item (if
available).

* You can select from among alternatives with A / %7 and press [8]4 to set.
* You can adjust using the slide bar with <]/ [> and press [8]4 to set.
* You can go to the next screen with [8]4.
* You can enter names or numbers freely for some items.
1) Enter characters one by one with and press m to set.

— You can set characters using [\[Vg[=lg(eRel¥jite]als.

EZE

EEIE]

EIED
[N

"M - Functions > Setting characters > Using Numeric buttons
2) Press [J{=0R8I3{)\| to store.
* To reset the settings

— To initialise picture or sound settings only, select Reset Picture Defaults
in the Picture Menu or Reset Sound Defaults in the Sound Menu.

— To initialise all settings, select Shipping Condition.

"M - Functions > Shipping Condition
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* To exit the menu screen
* To return to the previous screen
RETURN

= Note =

* Menu items and selectable options vary depending on the mode (TV
mode, Media Player, Network services, etc.).

* Some settings in Picture menu may also affect the menu screen when
watching content in 4K format.

* Depending on the model, the initial setting value of Viewing Mode may
differ between Home and Shop even when selecting the same viewing
mode.

The setting value can be adjusted by pressing \=\I8) and selecting
Picture.

B Using control panel buttons

. Press and hold INPUT/OK/HOLD for MENU button for 3 seconds to
display the menu.

-

2. Select and set with following control panel buttons.

* Move the cursor / select from a range of options / select the menu item
/ adjust levels

"""‘I +|-I
Y1 %0

* Access the menu / store settings after adjustments have been made or
options have been set with INPUT/OK/HOLD for MENU button
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Picture
Viewing Mode

Selects your favourite picture mode for each input.

"8 -+ Watching > For best picture > Viewing Mode
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Basic settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

Luminance Level, Backlight, Contrast, Brightness, Colour, Tint, Sharpness
Adjusts the levels of these options according to your personal preference.

"8 -+ Watching > For best picture > Basic settings

Colour Temperature
Sets the overall colour tone of the picture (bluer - redder).

"8 > Watching > For best picture > Basic settings

Vivid Colour
Automatically adjusts colours to vivid ones.

"8 > Watching > For best picture > Basic settings

Colour Remaster
Displays the vivid images with the expanded colour gamut.

"M - Watching > For best picture > Basic settings

Rec.2020 Colour Remaster
Displays the vivid images with the suitable colour gamut.

"8 > Watching > For best picture > Basic settings

Adaptive Backlight Control
Automatically controls the level of backlight according to the images.

"8 > Watching > For best picture > Basic settings

Resolution Remaster
Enhances picture resolution to make the image sharper.

"8 > Watching > For best picture > Basic settings

Dynamic Range Remaster

Enhances bright areas of the image closer to the original luminance making
improved picture impact.

"8 > Watching > For best picture > Basic settings
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Intelligent Frame Creation

Automatically compensates the picture frame rate and removes juddering
movements to make the images smooth.

"M - Watching > For best picture > Basic settings

Clear Motion
Makes the moving pictures clearer by controlling the level of backlight.

"M - Watching > For best picture > Basic settings
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Ambient Sensor
Automatic Brightness Control function

Adjusts picture settings automatically depending on ambient lighting
condition.

"8 - Watching > For best picture > Ambient Sensor
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HDR Brightness Setting

You can adjust and set up the details of HDR brightness.

M - Watching > For best picture > HDR Brightness Setting
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Noise reduction settings
Noise Reduction
Reduces unwanted picture noise.

"M - Watching > For best picture > Noise reduction settings

MPEG Remaster
Reduces flicker noise in contoured parts of a picture and block noise.

"M - Watching > For best picture > Noise reduction settings
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Advanced Settings
You can adjust and set up the detailed picture settings.

"M - Watching > For best picture > Advanced Settings
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Option Settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

Game Mode
Provides suitable images for fast response signals when playing games.

"8 -+ Watching > For best picture > Option Settings

Film Cadence Mode
Improves vertical resolution for movie images.

"8 > Watching > For best picture > Option Settings

1080p Pure Direct
Reproduces the original image quality in detail for 1080p (HDMI) input signal.

"8 > Watching > For best picture > Option Settings

4K Pure Direct
Reproduces the original image quality in detail for 4K (HDMI) input signal.

"8 > Watching > For best picture > Option Settings

1080p Pixel by 4pixels
Displays like pixel by pixel to make the image sharper for 1080p signal.

"8 > Watching > For best picture > Option Settings

HDMI Content Type

Adjusts the picture settings of each HDMI input according to the selected
content type.

"8 > Watching > For best picture > Option Settings

HDMI EOTF Type
Selects the EOTF type for each HDMI input. Set to Auto for general use.

"M - Watching > For best picture > Option Settings

EOTF Type
Selects the EOTF type of broadcast or video content.

"M - Watching > For best picture > Option Settings
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HDMI Colorimetry Type
Selects the colourimetry type for each HDMI input.
i“M - Watching > For best picture > Option Settings

HDMI RGB Range
Adjusts the black level of the image for each HDMI input.
i“M - Watching > For best picture > Option Settings

HDMI YCbCr Range
Adjusts the black level of the image in the YCbCr signal for each HDMI input.
"M - Watching > For best picture > Option Settings

3D-COMB
Makes still or slow moving pictures more vivid.

"M - Watching > For best picture > Option Settings
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Screen Settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

16:9 Overscan
Selects the screen area displaying the image for 16:9 aspect.

"8 -+ Watching > For best picture > Screen Settings

Zoom Adjustments
Adjusts the vertical position and size when aspect is set to Zoom.

"8 > Watching > For best picture > Screen Settings

Screen Display
Turns the screen off when you select Off.

"8 > Watching > For best picture > Screen Settings

Pixel Orbiter
Sets the pixel shifting of the image to prevent panel “image retention”.

"8 > Watching > For best picture > Screen Settings

Logo Luminance Control

Adjusts the luminance level of the displayed logo to prevent panel “image
retention”.

"8 > Watching > For best picture > Screen Settings

Panel Maintenance

Turns the screen off and perform the maintenance to prevent the panel
“‘image retention”.

"8 > Watching > For best picture > Screen Settings

Panel Maintenance Message
Enables to display the regular panel maintenance notification.

"8 - Watching > For best picture > Screen Settings
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Lock Settings

Only for the OLED TV

Locks the settings of Professional1 / 2 for each input.

"M - Watching > For best picture > Lock Settings
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Copy Adjustment

Some features are not available on all models. Available menu items are displayed on your TV screen.

Copies the picture settings of True Cinema, Custom, Professional1,
Professional2, Dolby Vision Bright or Dolby Vision Dark to those of the other
input mode or Viewing Mode.

"M - Watching > For best picture > Copy Adjustment
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Reset Picture Defaults

Resets the current Picture Viewing Mode to the default settings.
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Sound
Mode

Selects your favourite sound mode for each input.

"M - Watching > For best audio > Sound mode

-272 -



Basic settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

Bass
Adjusts level to enhance or minimise lower, deeper sound output.

M - Watching > For best audio > Basic settings

Treble
Adjusts level to enhance or minimise sharper, higher sound output.

"M - Watching > For best audio > Basic settings

Equaliser
Adjusts the frequency level to suit your favourite sound quality.

"M - Watching > For best audio > Basic settings

Balance
Adjusts the volume level of speakers.

"M - Watching > For best audio > Basic settings

Dolby Atmos

Provides the precise sound of Dolby Atmos when playing Dolby Atmos
content. Set to On for general use.

"M - Watching > For best audio > Basic settings

Sound Field Creation
Selects your favourite sound field setting.

"M - Watching > For best audio > Basic settings

Surround
Selects surround sound settings.

"M - Watching > For best audio > Basic settings

Bass Boost
Enhances the effect of bass sounds.

"8 - Watching > For best audio > Basic settings
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Volume settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

Speaker Selection

Enables controlling the theatre speaker with this TV’s remote control by
pointing at the TV’s signal receiver.

M - Watching > For best audio > Volume settings

TV Speaker Setting
Selects the sound output to adjust the volume.

"M - Watching > For best audio > Volume settings

Auto Gain Control

Automatically regulates large sound level differences between channels and
inputs.

"M - Watching > For best audio > Volume settings

Volume Correction
Adjusts the volume of each individual channel or input mode.

"M - Watching > For best audio > Volume settings

Clear Sound Adjustment

If the sound from TV speakers is unclear due to installation environment, On
is recommended.

"8 - Watching > For best audio > Volume settings

Dialogue Enhancement
Enhances the intelligibility of dialogue and commentary.

"8 - Watching > For best audio > Volume settings

Space Tune Setting

Adjusts the sound quality automatically according to the installation location
or room condition.

"8 - Watching > For best audio > Volume settings
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Headphone terminal output setting

Some features are not available on all models. Available menu items are displayed on your TV screen.

Sets the sound output from the headphone terminal.

"M - Watching > For best audio > Headphone terminal output setting
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Voice Guidance Settings
Voice Guidance

Set to On to enable voice guidance of the basic features (on-screen
messages, etc.) for visually impaired users.

"8 - Watching > For best audio > Voice Guidance Settings

Speed
Selects the readout speed for the voice guidance.

"M - Watching > For best audio > Voice Guidance Settings

Volume
Selects the volume for the voice guidance.

"M - Watching > For best audio > Voice Guidance Settings

Language
Changes language for the voice guidance.

"M - Watching > For best audio > Voice Guidance Settings

User Level
Selects the level of verbosity for the voice guidance.

"M - Watching > For best audio > Voice Guidance Settings

Web Browser

Set to On to enable voice guidance of the network content in web browser
function.

"M - Watching > For best audio > Voice Guidance Settings

- 276 -



Audio Description
Audio Description
Narration settings for visually impaired users

"% - Watching > For best audio > Audio Description

Volume
Adjusts the volume for Audio Description.

"M - Watching > For best audio > Audio Description
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Advanced settings
MPX
Selects multiplex sound mode (if available).

"M - Watching > For best audio > Advanced settings

Digital Audio Preference
Selects the initial setting for audio tracks.

"M - Watching > For best audio > Advanced settings

SPDIF Selection

Selects the initial setting for digital audio output signal from DIGITAL AUDIO
OUT and HDMI2 (ARC function) terminals.

"M - Watching > For best audio > Advanced settings

HDMI Audio Format
Selects the audio format for the HDMI input signal.

"M - Watching > For best audio > Advanced settings

PCM Optical Level

Adjusts the audio level of PCM output from DIGITAL AUDIO OUT and HDMI2
(ARC function) terminals to equalise with that of the other audio types.

"M - Watching > For best audio > Advanced settings

HDMI Input
Selects to fit the input signal.

"M - Watching > For best audio > Advanced settings
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Reset Sound Defaults

Resets the current Sound Mode to the default settings.
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Network

Network Connection
Sets the network setting to use this TV in your network environment.

i“M - Network > Network settings > Network Connection
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Network Status

Displays and checks the network status (MAC Address, current network
settings, etc.).

"M - Network > Network settings > Network Status
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TV Name

Sets your favourite name for this TV.

"M - Network > Network settings > TV Name

- 282 -



TV Remote App Settings
Sets to control the TV from network equipment (smartphone, etc.).

"8 - Network > Network settings > TV Remote App Settings
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Network Link Settings
Sets to control the TV with devices connected to the network.

"M - Network > Network settings > Network Link Settings
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TV Anytime Settings

You can set timer programming with the network equipment (smartphone,
etc.) from outside the home network.

¥ - Functions > TV Anytime > How to use
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Smart Speaker Settings

Controls this TV such as selecting a channel, changing volume, etc. with the
smart speaker function.

"8 - Network > Network settings > Smart Speaker Settings

- 286 -



Mirroring Settings
Settings for the mirroring function

"8 - Functions > Mirroring > Mirroring Settings
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Control4 Settings
Settings for the Control4 function

"M - Network > Network settings > Control4 Settings
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Other settings
VOD Content Refresh

Selects whether to update the VOD content to the latest even when the TV is
in Standby mode.

"% - Network > Network settings > VOD Content Refresh

Software Update

Accesses the specific website to update the TV’s software if any updates are
available.

"M - Network > Network settings > Software Update

New Software Message

Selects whether to give a notification message when new software is found
via network or not.

"M - Network > Network settings > New Software Message

Terms of Service and Settings
Displays the terms of service and settings.

"M - Network > Network settings > Terms of Service and Settings
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Timer
Off Timer

Sets the duration of time until the TV automatically goes into Standby mode.

"M - Watching > Basic > Off Timer
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Timer Programming
Sets a timer to record forthcoming programmes.

i“M - Recording > Timer Programming > Setting Timer Programming
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Clock Settings

Some features are not available on all models. Available menu items are displayed on your TV screen.

Mode

Selects the clock setting mode for this TV.

"8 -+ Watching > Basic > Adjusting time

Date
Sets the current date manually.

"M - Watching > Basic > Adjusting time

Time
Sets the current time manually.

"M - Watching > Basic > Adjusting time

Daylight Saving Time
Selects time offset from the standard time for Summer Time.

"M - Watching > Basic > Adjusting time

Select State / Territory
Selects the region where you live to adjust the standard time.

"8 - Watching > Basic > Adjusting time
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Auto Standby

Automatically turns the TV to Standby mode for energy saving when no
operation is performed for 4 hours.

8 - Watching > Basic > Energy saving functions
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No signal Power off

Automatically turns the TV to Standby mode to prevent unnecessary power
consumption when no signal is received and no operation is performed for
10 minutes.

M - Watching > Basic > Energy saving functions
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Setup

Eco Navigation
Automatically sets the TV to the most suitable energy-saving mode.

8 - Watching > Basic > Energy saving functions
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USB Device Setup
Formats the USB HDD or safely removes USB device.

"M - Recording > USB HDD setup > Setting for USB HDD
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Recording Setup
Settings for the recording feature of the USB HDD

"M - Recording > Recording current programme > One Touch Recording
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Bluetooth Setup
Settings for the specific devices supporting Bluetooth wireless technology

"8 - Functions > Bluetooth devices > Bluetooth Setup
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Child Lock

Applies access control for channels or inputs to prevent unwanted access.

"M - Functions > Child Lock > Using Child Lock

- 299 -



Tuning Menu

Some features are not available on all models. Available menu items are displayed on your TV screen.

Favourites Edit
Creates a list of favourite channels.

i“M - Watching > Tuning and editing channels > Favourites Edit

Channel List
Skips unwanted channels or edits channels.

"M - Watching > Tuning and editing channels > Channel List

Auto Tuning
Automatically searches for receivable channels.

"8 - Watching > Tuning and editing channels > Auto Tuning

Manual Tuning
Searches for channels manually.

"M - Watching > Tuning and editing channels > Manual Tuning

Update Channel List
Updates the channel list while keeping your settings.

"M - Watching > Tuning and editing channels > Update Channel List

New Channel Message

Selects whether to give a notification message when a new channel is found
or not.

"M - Watching > Tuning and editing channels > New Channel Message

Signal Condition
Checks the signal condition.

"M - Watching > Tuning and editing channels > Signal Condition

Antenna System
Sets the antenna system to use plural LNBs for receiving several satellites.

"8 - Watching > Tuning and editing channels > Auto Tuning
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LNB Configuration
Selects the satellite for each LNB.

"M - Watching > Tuning and editing channels > Auto Tuning

Add TV Signal
Adds the TV mode.
i“M - Watching > Tuning and editing channels > Add TV Signal

= Note =

* The settings in Tuning Menu are applicable only for the selected TV mode.
The menu name varies depending on the TV mode. (Satellite TV Tuning
Menu / Digital TV Tuning Menu / Analogue TV Tuning Menu)
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Language

Some features are not available on all models. Available menu items are displayed on your TV screen.

OSD Language
Changes language for on-screen displays.

"8 - Watching > Basic > Language

Preferred Audio Language

Selects the preferred language for digital channel multi audio (depending on
the broadcaster).

"8 - Watching > Basic > Language

Preferred Subtitles

Selects the preferred language for digital channel subtitles (depending on the
broadcaster).

"8 - Watching > Basic > Language
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Display Settings
Some features are not available on all models. Available menu items are displayed on your TV screen.

Subtitle Type
Selects the preferred subtitle type.

"M - Watching > Basic > Subtitle

Teletext
Selects teletext display mode.

"M - Watching > Teletext > Teletext mode

Input Labels

Accessing the input labels list allows you to change the input name or skip
the input if unconnected, improving identification and selection in the Input
Selection banner.

- | Watching > External equipment > Watching external input

Banner Display Timeout
Sets how long the information banner stays on screen.

"M - Watching > Basic > Information banner

Playing Time Display

Set to On to display a time period of continuous use in Game Mode on the top
right of the screen every 30 minutes.

- | Watching > External equipment > Watching external input

Notification
(On / Off)

Displays a notification message.

Dolby Notification
(On / Off)

Displays a Dolby notification.
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HDMI Auto Setting

Set to Mode1 when the image or sound in HDMI input is not played properly.

"M - Watching > 4K resolution > HDMI Auto Setting
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HDMI HDR Setting

Settings for input signal from the connected HDR device

"M - Watching > External equipment > HDMI HDR Setting
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HDMI 2.1 Settings

Automatically switches the TV to Game Mode according to the ALLM
information when using this TV in single window mode.

"M - Watching > External equipment > HDMI 2.1 Settings
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VIERA Link Settings
VIERA Link
Sets to use VIERA Link functions.

"8 - Functions > VIERA Link “HDAVI Control™” > Preparations

Power on Link
Sets to use Power on Link functions.

"M - Functions > VIERA Link “HDAVI Control™” > Power on Link

Power off Link
Sets to use Power off Link functions.

"M - Functions > VIERA Link “HDAVI Control™” > Power off Link

Standby Power Save
Controls the connected equipment to reduce power consumption in Standby.

"M - Functions > VIERA Link “HDAVI Control™” > Standby Power Save

Intelligent Auto Standby

Makes non-watched or non-used connected equipment go into Standby mode
to reduce the power consumption.

"M - Functions > VIERA Link “HDAVI Control™” > Intelligent Auto Standby
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Data Service Application

Service
Sets to use Hybrid Broadcast Broadband TV application.

"8 - Functions > Data Service Application > Using Data Service Application

Privacy Setting
Settings for the privacy in the interactive data services

"M - Functions > Data Service Application > Privacy Setting
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System Menu
Shipping Condition
Resets all settings to the original condition.

"8 - Functions > Shipping Condition > Shipping Condition

System Update
Downloads new software to this TV.
"M - Functions > Updating the TV Software > Auto update

"M - Functions > Updating the TV Software > Manual update

Licence Menu

Displays the software licence information.
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Other Settings

Power Save
(On / Off)

Reduces brightness of the picture to economise on power consumption.

Power LED Indicator
Selects the power LED indication mode.

"8 - Functions > Power LED Indicator > Using Power LED Indicator
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Support

Help menu

Using Help menu
1. Display the menu with \Ji=\18).
2. Select Help and press [8]4 to access.

3. Select TV Self Test / System Information / Device Information and press
to access.

TV Self Test
Makes a diagnosis of picture or sound problems.

Follow the on-screen instructions.

System Information

Displays the system information of this TV.

Device Information

Displays the device information of this TV.
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FAQS

Picture

Some features are not available on all models. Available menu items are displayed on your TV screen.

Before requesting service or assistance, please follow these simple guides to
solve the problem. Also makes a diagnosis of picture problem in TV Self Test.

"M - Support > Help menu > Using Help menu

If the problem still persists, please contact your local Panasonic dealer for
assistance.

Black and white picture

* Check that the output of the external equipment matches the input of the
TV.

Chaotic image, noisy

¢ Set Noise Reduction and MPEG Remaster in the Picture Menu to remove
noise.

"M - Watching > For best picture > Noise reduction settings

* Check nearby electrical equipment (car, motorcycle, fluorescent lamp).

No image is displayed

* Check the correct input mode is selected.

* Check the setting of AV (COMPONENT / VIDEO) in Input Selection to
match the signal being output by the external equipment.

"M - Watching > External equipment

Is Luminance Level, Backlight, Contrast, Brightness or Colour in the
Picture Menu set to the minimum?

"8 -+ Watching > For best picture > Basic settings

Check all required cables and connections are firmly in place.

Blurry or distorted image (no sound or low volume)

¢ Reset channels.

"M - Watching > Tuning and editing channels > Auto Tuning
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White spots or shadow images (noise)

* Check the position, direction and connection of the aerial.

There may be a short black image

* Ablack image is displayed to avoid picture distortion when an input signal
changes.

There may be white spots, red spots, blue spots, green spots and black spots
on the screen

* Animage on a TV screen is created by many small groups of dots known
as pixels (which is similar to the image in a newspaper). It also naturally
follows that higher panel resolutions contain more pixels. To create a
colour image, each pixel consists of three tiny coloured dots (known as
sub-pixels), one each of red, green and blue. Each one of these dots is
precisely controlled by the electronics of the TV to produce the picture.
Whilst Panasonic maintains the highest standards in manufacturing
technology and processes in the construction of these panels, there are a
number of allowable pixel / subpixel failures that still allow the panel to be
defined as a good panel. It is not possible to guarantee absolutely no pixel
loss.

Shop appears on screen at switch on

* Shop was selected in first time Auto Tuning when the TV is turned on for
the first time. Reset settings in Shipping Condition, then select Home in
first time Auto Tuning.

"8 - Functions > Shipping Condition > Shipping Condition

Only for the OLED TV

A white horizontal line appears in Standby mode

* A white horizontal line may appear on the screen for a while to adjust the
panel. This is not a malfunction.
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Digital TV

Some features are not available on all models.

Before requesting service or assistance, please follow these simple guides to
solve the problem.

If the problem still persists, please contact your local Panasonic dealer for
assistance.

* Due to the digital reception technologies involved, quality of the Digital TV
signals may be relatively low in some cases, despite good reception of
Analogue TV channels.

No satellite channel is found

* Set LNB Band Frequency in LNB Configuration to suit your environment.

"M - Watching > Tuning and editing channels > Auto Tuning

Unable to receive signals with a high-performance aerial

* |nstall an aerial individually for the TV and VCR (or use a splitter).

Interference or frozen / disappearing image

* Check Signal Condition. If the level of Signal Quality is low, check aerial or
dish.

"M - Watching > Tuning and editing channels > Signal Condition

* Turn the TV off with Mains Power On / Off switch, then turn it on again.

Faulty dish message appears

* The satellite cable may be short-circuited or there may be connection
problems of the cable. Check the cable and connection and then turn the
TV off with Mains Power On / Off switch, and turn it on again.

* |If the message persists, consult a dish installer for checking the dish and
cable.
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Sound

Before requesting service or assistance, please follow these simple guides to
solve the problem. Also makes a diagnosis of sound problem in TV Self Test.

"M - Support > Help menu > Using Help menu

If the problem still persists, please contact your local Panasonic dealer for
assistance.

No sound is produced

¢ |s “Sound mute” active? Press |/l8ll= to switch sound mute on or off.

¢ |s the volume set to the minimum?

Check connections and setting of external equipment.

"M - Watching > External equipment

Ensure that Speaker Selection is setto TV.
i“M - Watching > For best audio > Volume settings

"M - Functions > VIERA Link “HDAVI Control™” > Speaker Selection

Ensure that TV Speaker Setting is set to TV Speaker.

"M - Watching > For best audio > Volume settings

Sound level is low or sound is distorted

* Sound signal reception may be poor.
* Set MPX in the Sound Menu to Mono. (Analogue TV)

"M - Watching > For best audio > Advanced settings
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HDMI

Before requesting service or assistance, please follow these simple guides to
solve the problem.

If the problem still persists, please contact your local Panasonic dealer for
assistance.

Sound is unusual

* Check the setting of HDMI Audio Format in the Sound Menu to match the
audio signal from the connected equipment.

"M - Watching > For best audio > Advanced settings
Check the HDMI Input setting in the Sound Menu.

M - Watching > For best audio > Advanced settings

If digital sound connection has a problem, select analogue sound
connection.

- | Watching > External equipment > HDMI features
Set HDMI Auto Setting in the Setup Menu to Mode1.
"M - Watching > 4K resolution > HDMI Auto Setting

Pictures from external equipment are unusual when the equipment is
connected via HDMI

* Check the HDMI cable is connected properly.
- | Watching > External equipment > External connection

e Turn the TV and equipment off, then turn them on again.

Check an input signal from the equipment.

"M - Watching > External equipment > Valid input signals
* Use equipment compliant with EIA/CEA-861/861D.
Set HDMI Auto Setting in the Setup Menu to Mode1.

"M - Watching > 4K resolution > HDMI Auto Setting

The valid 4K format varies depending on the HDMI terminal.

"M - Watching > 4K resolution > Valid 4K format

- 316 -



Network

Before requesting service or assistance, please follow these simple guides to
solve the problem.

If the problem still persists, please contact your local Panasonic dealer for
assistance.

Cannot connect to the network

* Check the LAN cable or wireless LAN is connected properly.
"8 - Network > Network connections

* Check the connections and settings.
"8 - Network > Network connections
"8 - Network > Network settings

* Check the network equipment and network environment.

* The router may not be set to issue IP address automatically. If the
network administrator prefers to allocate an IP address, set an IP address
manually.

"M - Network > Network settings

* The router may be using MAC address filtering (security setting). Confirm
the MAC Address of this TV and set the router to use it.

"M - Network > Network settings > Network Status

* |If the problem persists, consult your Internet Service Provider or
telecommunications company.

Cannot select the file during in-house streaming operations

* |s media server of the connected equipment prepared?
"M - Network > Home network > In-House streaming

* Check applicable data format.
"M - Network > Supported format

* Check the settings of Network Link Settings.

"M - Network > Network settings > Network Link Settings
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Cannot operate internet content

* Check the connections and settings.
"8 - Network > Network connections > Internet connection
"M - Network > Network settings

* The server or connected line may be busy now.
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Other

Some features are not available on all models.

Before requesting service or assistance, please follow these simple guides to
solve the problem.

If the problem still persists, please contact your local Panasonic dealer for
assistance.

VIERA Link function does not work and an error message appears

* Check the connections.
"M - Functions > VIERA Link “HDAVI Control™” > Summary of VIERA Link
e Turn the connected equipment on and then switch the TV on.

"8 - Functions > VIERA Link “HDAVI Control ™"

Parts of the TV become hot

» Parts of the TV may become hot. These temperature rises do not pose
any problems in terms of performance or quality.

Overcurrent error message appears

* The connected USB device may cause this error. Remove the device and
turn the TV off with Mains Power On / Off switch, then turn it on again.

» Check foreign objects are not inside the USB port.

An error message appears

* Follow the message’s instructions.

* |f the problem persists, contact your local Panasonic dealer or the
authorised service centre.

LED does not light.

» Set Power LED Indicator in the Setup Menu to On.

"M - Functions > Power LED Indicator > Using Power LED Indicator
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LED does not turn to red in Standby mode

e LED turns to orange in Standby mode in the following conditions:
— Recording is in progress.
— Timer Programming is set.
— Home Network Server is set to On.
— Powered On by Apps is set to On.
— Home Streaming is set to Always.
— VOD Content Refresh is set to On and VOD content is updated.
— TV Anytime is set to On.
— Powered On by Easy Mirroring is set to On.

* LED turns to orange during adjustment of the panel (approx. 10 minutes to
maximum 80 minutes). LED turns to orange again in standby mode when
the TV is turned on / off before the panel adjustment is completed. (Be
sure to turn the TV off with the remote control to adjust the panel.)

The panel maintenance notification is displayed when turning the TV off with
Standby On / Off switch of the TV’s remote control.

« Perform the panel maintenance. Select Turn the TV off now and press [8]4
to start the panel maintenance.

— The panel maintenance is interrupted when selecting Don’t start panel
maintenance this time or turning the TV off while the notification is
displayed.

When pushed with a finger, the display panel moves slightly and makes a
noise

* There is a little gap around the panel to prevent damage to the panel. This
is not a malfunction.
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Detailed information

Support information about the application, optional devices, operation, etc.
may be found on the following website.

http://panasonic.jp/support/global/cs/tv/ (English only)

- 321 -



Maintenance

Care and Cleaning

First, remove the mains plug from the mains socket.

B Display panel, Cabinet, Pedestal

Regular care:

Gently wipe the surface of the display panel, cabinet, or pedestal by using
a soft cloth to remove dirt or fingerprints.

For stubborn dirt:

1) First clean the dust from the surface.

2) Dampen a soft cloth with clean water or diluted neutral detergent
1 part detergent to 100 parts water).

~ o~ o~ o~

3) Wring out the cloth firmly. (Please note, do not let liquid enter the TV
inside as it may lead to product failure.)

(4) Carefully wipe moisten and wipe away the stubborn dirt.

(5) Finally, wipe away all the moisture.

= Caution =

Do not use a hard cloth or rub the surface too hard, otherwise this may
cause scratches on the surface.

Take care not to subject the surfaces to insect repellent, solvent, thinner
or other volatile substances. This may degrade surface quality or cause
peeling of the paint.

The surface of the display panel is specially treated and may be easily
damaged. Take care not to tap or scratch the surface with your fingernail
or other hard objects.

Do not allow the cabinet and pedestal to make contact with a rubber or
PVC substance for a long time. This may degrade surface quality.

Mains plug

Wipe the mains plug with a dry cloth at regular intervals. Moisture and dust
may lead to fire or electrical shock.
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